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APPLICATION WINDOW 
Project 
There is always one project active at a time. A project contains products and their 
parameters. You can save or load projects to/from a file. Graphics resources used in a 
project are only referenced to their original location on your hard drive. 
 
Products contained in the project are shown as buttons in the Product bar (2). Products can 
be added to current project via Insert menu item. Product parameters can be changed via 
popup menu (use right mouse click) on the product button. 

Products in the Product bar can be reordered by Drag and Drop gesture. 

Video Preview 

Video preview renders the scene, which includes video and graphics. The preview doesn't 
show exactly output of the system, video in the preview is scaled to fit the screen 
dimensions. 

Preview is used to prepare the graphics for production (see Product chapter.) 
It is possible to zoom the preview (via menu item View or keyboard shortcuts). When 
zoomed-in, you may need to view another area of the preview. Use the scrollbars or use 
drag by middle mouse button to pan the preview. 



 

                              
 

6   |   Virtual Placement User Guide (v8.1)  

PRODUCT 
Product is a container for graphics art that is going to be presented. Product button 
consists of two parts. An image button (1) and label button(2). The image button shows a 
thumbnail of the product. Label button shows product's name and indicates On-Air status 
by background color.  

Insert product:  
Use Insert menu in the application menu or in the popup menu for Product bar. 

Delete product:  
Use Edit → Delete menu item to delete last selected product or Delete menu item from 
popup of the product to delete. 

Delete All selected products:  
Use Edit → Delete All Selected to delete all selected products from the project.  

Lock product bar:  
Menu View → Ability to order products within the product bar and then lock the position of 
the product. 

Select product:  
Click the product button. The product starts to be rendered in preview. All other products 
will get unselected.   

Click the products with CTRL key down to invert selection of a product. All other products 
keep their state. 

Click two products with SHIFT key down to select all products between the two clicked. 
When you hover the product button, corresponding product is highlighted in the video 
preview - outline of the product is rendered in contrast color.  

State of the products is reflected by the background color of the label button. 

 Default state. The product is neither in 
preview nor in production. Only takes place 
in the product bar. 

 Products in preview. You can manipulate 
them, but the product is not in production 
(not on air) 
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 Products in production. Product with 
defined on-air duration shows the time left 
as orange/red progress bar. After the 
product finishes playing, it automatically 
goes to state Preview-only. 

 

When the product is in the preview, click the label button to set the desired product to 
production. All others will stop playing. To add a product to production together with other 
products, you have to hold CTRL key down before clicking the label button. 
 
To put more products on-air at the same time, select them all with CTRL,  so all are in the 
preview and use the GO button. There are several ways the production is finished. 

● When your press the GO button again while in production 
● After the duration of the product expires. This is a case of clips with non-loop 

behavior and products having set Duration property. 
● Lost of tracking, for example scene cut in motion tracking. 

Adjusting Position and Size 
Select desired product. Drag it to desired position. 
Some tracking types offers a special Perspective Move manipulator (see 1). Dragging the 
object by this manipulator moves the object with the current perspective defined by this 
product.  

Use the resize manipulator (2)  to adjust size (tip: hold CTRL to resize the product in one 
axis only). You can rotate the product by the rotation manipulator (3). The rotation is done 
either in pitch (pitch tracking), screen (most of tracking types), or content local space (most 
of tracking types, hold SHIFT). 

There are also corner manipulators (4) for non-linear perspective skew. Holding SHIFT while 
dragging corner manipulator moves horizontal neighbor in a mirror direction. Holding CTRL 
moves vertical neighbor in parallel. 

 
Billboard Manipulator 
Billboard tracking type provides distinctive set of manipulators. 
Use billboard area (1) to move the billboard around the pitch.  
To change the size of a billboard, use the resize manipulator (2). 
You can rotate billboard around its vertical axis by using rotation manipulator (3). 
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To adjust billboard height above the field, use the manipulator (4). 
 
Tip: To lean billboard back or front, use Rotation value in the Geometry rollout. 
 

Color Correction 

This allows you to adjust the colors of the product to fit current scene.  
Parameter Alpha Gain changes linearity of key channel. This can be used when a product 
is too transparent or not transparent enough. 
Parameter Opacity changes transparency. Value 0 is fully transparent. Value 1.0 is fully 
opaque. 

Tracking  

With tracking enabled the products can hold the position on the pitch where they were 
placed in the host environment. 

None Tracking is disabled. Camera movement has no effect on product 
position. 

Motion Motion tracking is used to keep graphic object in the position in the 
scene. The tracking relies on textured scene. Tracking works reliably 
when camera movement is smooth and scene background has 
textured surfaces. The tracking drifts over time. 

Standby Motion Combination of None and Motion tracking. When the product is in 
preview, but not on-air yet, it behaves like None. As soon as you put 
the product on-air, it begins to behave like Motion tracking. This type 
of tracking is useful to set precisely place where the production 
begins. Later, just press the GO button and the production will 
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behave like motion tracked. 

Anchor Graphics keeps its position in the anchor scene. See Anchor 
Tracking chapter  for more detailed information. 

Pitch Automated tracking and localization. Properly defined pitch or 
calibrated camera needed. See Camera Tracking for sports chapter . 

Billboard Similar to the Pitch tracking. The product stands-up vertically on the 
pitch. 

Billboard Facing The billboard is automatically rotated to always face the camera.  
 

Keyer and Fade 
Set a product to use chroma key by choosing one of the chroma keys available. Chroma 
keyers insert the graphics to the video only for areas where the color matches the settings 
of the keyers. 

Chroma keyer 

Chroma filter During chroma key processing a filter is used to soften 
edges and reduce edge aliasing. Use “BLUR” to set it on 

Chroma Spill Used to prevent spilling of the background color on the 
edges of the keyed graphics. There are choices to prevent 
spill for the most used keying background colors.  
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Effects of the Filter and Spill suppression (keyed on green background): 

1) Upper left image – both Filter and Spill suppression OFF 
2) Upper right image – Filter OFF, Spill suppression GREEN 
3) Lower left image – Filter BLUR, Spill suppression OFF 
4) Lower right image – Filter BLUR, Spill suppression GREEN 

You can get to the chroma key dialog through the chroma keyer button from the main 
toolbar.  See more info in chapter Chroma Keyer. 

Fade 
Fade in/out are effects used at the beginning resp. end of the production. You can change 
the duration by setting new value to corresponding box. Mind that all values are in video 
field units. 
 
Duration 
You can specify the duration of production for several products without the need to end the 
production manually. Duration is set in field units. Mind that the real duration is this value 
plus duration of fade in/out.  
 
File 
Using this menu item in the corresponding product you can change the source file for the 
product (source image, clip, source free hand style...) 
Although most product types do not follow file content change while in production, image 
products are able to update on-fly. Whenever the image file changes its content keeping 
the same size and packing, the image product is updated to reflect file change. 
 
Production Type 
Depending on the product type, it is possible to choose different mode of production 
control. 
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DIRECT Production is controlled directly by the GO button. 

AUTO Selecting the product tells the system to start production whenever it 
becomes visible (see detection types). 
After the product goes out of view, the production automatically stops. 
To start/stop production, the product must become visible/invisible for 
at least Decision Time frames. 
Two different visibility detection types can be used: 

� Tracking And Visibility – to be put in production, a product must 
have tracking available and must be inside the viewport 

� Tracking – to be put in production, a product must have tracking 
available, no matter if it is visible inside the viewport. 

Pressing the GO button can be used to stop ongoing production. After 
eventually leaving the view and coming back, the production starts 
again automatically. 

SEQUENTIAL 
(Group) 

After pressing GO, group members with definite production time are 
produced one after one. Any members with infinite production time are 
produced in parallel. 

PARALLEL 
(Group) 

After pressing GO, production of all grouped products starts 
immediately. 

Geometry 
Geometry rollout allows to change numeric geometry properties, like position and size. 
Depending on the tracking type, the editor uses different units. 

Screen relative units 
[-1,-1] left bottom, [1,1] right top corner of 
screen 

None, Motion, Standby-Motion, Anchor 

Pitch meters Pitch, Billboard, Billboard Facing 
 

Clip 
Clip parameter window allows to set basic clip properties. 

 

Preview Frame Select frame to be visible in preview window when clip is not playing. 

Play ► Play clip in preview window only. The clip will not be visible on video 
output. 

Loop ● Once – Play clip once 
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● Infinite – Play clip in a loop forever. Stop the payback by 
turning off production.  
● Custom – Play clip in a loop for defined number of iterations. 

Loop Start Set start point for looping. Frames before Loop Start are played 
once, the rest of the clip loops for defined number of periods set in 
the Loop property.  

 
Pause 

 
Set pause points in the clip. Clip playback automatically pauses at 
selected positions. To resume playback press “Go” again.  
To set a pause point, select preview frame to requested pause point 
and press +  
To remove a pause point, select the pause point in the selection box 
and press -  

Volume Changed audio volume. If the clip contains audio you can adjust clip 
volume to match the background audio levels. Slider has range 0 – 
100% 

Text 
Content of the text and text properties can be edited in the Text editor. It is available in the 
popup menu of the Text product, or clicking on the small context button in the lower left 
corner of the product button. The context button gets visible after selection. 
 
In the case of a text product, you're allowed to control formatting of the text. The text itself 
can contain special formatting sequences beginning with a backslash (\) character. See 
below the table of possible format sequences.  

\< Decrease kerning space between the two surrounding characters. Number of 
'<' means the amount of extra kerning. Sequence \< decreases kerning of one 
unit. Sequence /<<< decreases kerning of 3 units.  

\> Increase kerning space between the two surrounding characters. Number of 
'>. means amount of extra kerning as above. 

\\ Backslash itself.  

\s Non breaking space.  

\n New line. 

\uXXXX Unicode character with XXXX unicode hex value. 

\iu The following text will be rendered as the upper index. To end the upper index 
part and continue with normal text, use \in switch. 

\il The following text will be rendered as a lower index.  

\in The following text will be rendered as normal text. 
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 Text “Text\iuupper\illower\inIndex” will be rendered as: 

 
Usage of Application Variables 
Text product allows you to use symbolic name of a variable, which is automatically 
translated to its value. Syntax of variable usage: 
$(variable_name) will be translated to variable_value. 
List of available variables is defined in Appendix C – Application Variables section. 
 
Text presets 
User Field Product = Virtual Placement allows you to prepare several version of text 
products. So you can have only one text product and switch between text strings.  
 
In the text editor, you can see list of text presets (1). If you choose one of them, it will be 
copied to the text field and used in the text product. To add a text preset, just enter the text 
to the text field and press add button (2). To remove a preset, choose it in the list of presets 
and press the remove button (3). 
Text presets are saved to the project file, so they are available only in one project.  
 
Resolution 
The higher the value is, the smoother text will be displayed. Adjust the text resolution before 
production to fit the smoothness requirements.  
 
Alignment 
For one line texts the products have minimal  bounding box and the alignment change 
doesn't take effect. For multiple line texts you can choose alignment. 

Billboard Shadow 
Billboard tracking provides the ability to apply a shadow to the billboard this can be found 
by right clicking the product and selecting shadow from the dropdown menu.
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The shadow option provides the following settings in order to adjust the billboard shadow. 

  

Enabled Enables and disables shadow. 

Texture Select file for billboard shadow. 

Opacity Adjusting the transparency. 

Offset Ability to offset the shadow from the billboard. 

Scale Adjusting the size of the shadow. 
 
3D Billboard  
Billboard tracking provides the ability to apply depth of field to the billboard this can be 
found by right clicking the product and selecting depth from the dropdown menu. 
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Side Texture Applies texture to 3D billboard. 

Depth Increase or decrease depth of field. 

Opacity Adjust how many side pixels are visible. 

Video Input 
Video input product allows to insert incoming SDI video feed into another feed. In the Video 
editor available from the popup menu of the product button you can choose video source 
for the product: 

● background feed (equals to the actually selected camera) 
● auxiliary video texture feed. This feed must be configured as texture feed and is not 

listed among other camera feeds. 

 
Keying  
There are 2 keying types associated with the Video input: 
Keying on the background of another feed (Keyer and Fade popup menu item) 
Using own key to remove background from the Video texture feed (Video Keyer popup 
menu item). 
 
Setting chroma key for the video texture   
Select the video texture feed in the camera selector in the main toolbar. The video texture is 
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shown in the preview. Follow the instructions for chroma key picking in the Chroma Keyer 
chapter. 
 
Cropping  
The texture itself might contain unwanted artifacts on the edges. Open the editor using the 
Video Keyer popup menu item and set crop boundaries. Video space has range of -1..1 in 
both axes, having 0 in the middle. Set e. g. -0.8..0.8 to crop 10% on each side. 
 

Free Kick 
Freekick needs properly calibrated cameras.  
 
Freekick has two modes of production: Radius and Arrow. To switch between modes, use 
freekick rollout buttons. Alternatively, you can use a Numpad-period keyboard shortcut. 
 

Radius mode 
Radius mode shows animated circle around the ball position which should be clear of 
defending players. The size is automatically computed from calibration to be exactly 9.15 
meters (10 yards). 
 
Arrow mode 
Arrow is used to show an arrow and distance of the free kick position to the goal. Head of 
the arrow is automatically placed to the middle of the goal and text with distance is added 
automatically as well.  
 
Distance label 
In Arrow mode also label with distance of the ball to the goal is shown. The distance can be 
shown virtually on the pitch, next to the ball. Adjust label position using the mouse wheel.  
 
2D title label 
You can also use 2D title on the screen. To use this label mode, create new Free Kick 
product using the product editor for freekick. Guide to create 2D title is in the appendix of 
this document, Free Kick Style editor section. 
 
Events 
When freekick manipulator is moved, ball distance changes are sent in form of events. 
<Event app="VP" source="freekick"> 
  <GoalDistance value="46.656567"/> 
</Event> 
 
Ball Speed 
If the ball speed is enabled (see Freekick Style Editor below), it is automatically computed 
during every freekick. The result is ready to use immediately after the kick. Computed value 
is shown in the freekick editor, next to the Arrow/Radius switch. Press the Ball Speed 
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button, and the label with the speed is shown. Production of Arrow/Radius is automatically 
finished. 

The style of the label is configurable. To customize the label appearance, use the Free Kick 
Style Editor, described in the appendix. 

Free Kick Style Editor 
Free Kick style editor allows you to change the appearance of the free kick graphics. First 
open an existing freekick style or create a new one. Open and New actions are available in 
the menu. Change the setting and don't forget to save. As the style is customized, new 
freekick products can be created. Just select the appropriate freekick style during adding 
new freekick products. Freekick settings are copied to the freekick product during load, it 
means style change is not applied on other freekick products having the same style. 

 
A. Arrow  

1. Select arrow image/clip. The image should have “stretchable” areas. It means, area 
that is stretched to fit the distance from ball to the goal. In the case of clip you can 
choose play loops and preview frame (Pivot frame). (1) 

2. Define image bounds and stretchable areas (Stretch start and Stretch end). You can 
do that in graphic preview (2) or numeric editors (3). In case of the image is not well 
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seen, you can swap between bright and dark background patterns via preview pop-
up menu. This feature is available in all style editors with image or clip preview. 

3. Set play options – Fade in/out, thickness and growth duration (in frames).  

 

B. Radius 
Shows 9.15 m (10  yards) radius around the ball.  

1. Select clip to play. (1) It is recommended to enable loop for shorter clips. You can 
set Loop Start frame when loop is enabled. See Clip product for more information 
about Loop start. Pivot frame is equal to pause frame in case of no loop. 

2. Set clip boundaries. Center is where the clip will be dragged. Recommended to 
keep the value in the middle of the clip frame.  

3. Set fade in/out and alignment:Right edge toward goal: The radius 'points' to the 
middle of the goal. 
Pitch aligned: The radius is 'parallel' to the pitch side lines. 
 

C1. Virtual Label 

1. During the arrow production, a label with distance is shown. Select On Pitch (1) 
choice to have virtual text next to the ball. 

2. Select font and color. Set format. Usually, accuracy to one decimal place is enough. 
Set format to “#.#0 m” for one decimal place.  

3. Set text height and distance from the ball position.  
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C2. 2D Label 

1. Select 2D title in the mode field. 
2. Set text properties. Same as On Pitch Label.  
3. Select image background for the title. Set size (pixels) and position of the label 

background. Position of the label is in normalized coordinates, it means <-1..1> in 
both x and y axis. [-1,-1] is in the lower left corner of the screen, [1,1] in the upper 
left corner.  We prepare graphic and more intuitive 2D title adjustment.  

4. Set position of the text. Position is set relative to the screen, it means the same way 
as point 3. 

5. Set fade in/out. 

 

D. Ball Speed Label 
Customizing Ball Speed Label is pretty much the same as 2D Distance title. Editor for this 
property has the same structure and the fields have the same meaning. 
 

Offside 
Offside needs properly calibrated cameras. Also make sure, offside cameras are recorded 
(see Multiple camera I/O in this document and Installation Guide, section Cameras.) Offside 
is desired to be fully controlled from the MCS3 Jog/Shuttle. 

Offside Workflow 

1. Add offside product to the project. Offside is selected and put on air automatically 
to speed up the offside preparation. There's no need to select/put on air manually. 
Always the first (the left most in the product bar) is used.  

2. An offside situation happens. 
3. Stop the live feed using the STOP button on the Jog/Shuttle.  
4. The camera is automatically switched to recorder so you can see the end of the 

recorded footage. At this point you can still switch between recorded cameras. The 
offside product is automatically selected and inserted into the video. 
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5. Jog back to the time of the offside.  
6. Click at the last defending player. The offside line is placed at the position of the 

mouse. It can be adjusted after position has been set. The current timecode (Offside 
Time) is used as a pause point when the offside video is replayed. 

7. The offside has been set. Jog back in time (~ 3 seconds) or use the Preroll button, 
which jumps specified seconds back (preroll time in seconds can be specified in 
Config Editor at tab Controller as value of action Preroll). This is to start the offside 
playback smoothly.  

8. Press the ON-AIR button (W6) 
9. Play the offside by the Play button. Playback speed is configurable and default value 

is 100%. You can set different speed from the application menu for playback 
actions or assign multiple playback actions with different speed to the Jog/Shuttle 
buttons. More in the Installation Guide, chapter Jog/Shuttle. Current speed, that will 
be used for playback, is displayed in the status bar during recorder-playback mode.  

10. From actual point the playback begins and it is paused at Offside time defined in 
point 6. Here the playback smoothly stops. You can jog around to show the offside 
sequence slowly. 

11. Press the Play button. It starts playback until the end of the recorded footage.  
12. Press the ON-AIR button again or switch to live camera to finish the offside 

production.  
13. You can export played footage as offside clip, and replay it later. The recorded 

footage is otherwise rewritten as you get back to live camera. See RAM Recorder 
chapter. The export process is executed on the background. So you can use the 
system while the exporting is still in progress. 
 

Two offside lines in one clip 
Fifa rules allow to have 2 offside situations, one after another. You can define 2 offside 
lines, one for each situation. 
 
The workflow for the second line: 

A. Follow steps 1-6 from above 
B. Jog to the 2nd offside situation 
C. Press Add offside button next to the Offside product button. 
D. Click the last defending player again.  
E. Follow the steps 7-10 from above 
F. The playback is stopped on the first offside situation. Press play. The first offside 

fades out and the playback plays forward to the 2nd situation, where it smoothly 
stops and shows the 2nd offside line.   

G. Follow the steps 11-13 from above. 

During the offside production and preparation, you can see timeline with marked 
timecodes. 
1) Timecode where the live playback was stopped and recorder activated.  
2) Timecode, where the offside was placed 
3) Timecode, where are you now in the recorded footage 
4) Timecode, where automatic rewind is provided by pressing the Preroll button.  
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The timeline shows small white ticks corresponding to one second of the recorded footage. 
 

Offside Style Editor 
Offside style editor serves to customize offside graphics appearance.  

1. Texture 
You can change the graphics of the offside line. Either still images or GTC clips are 
supported.  

2. Offside line and offside shadowing. 

Specify which part of the graphics should be used as line at position of the offside. 
The rest of the graphics will be stretched to fill the rest of the pitch. 

3. Other settings 
- Fade in/out: fade of the graphic in field units.  
- Width – width of the offside graphics (line + shadowing). The line is drawn in 
perspective, the width value specifies the number of pixels of the offside graphics at 
the bottom of the screen. 
- Line over – when set to 0, the offside lines begins and ends at pitch side lines. You 
can set any value higher (in pitch meters), and the line will overlap side lines. 

4. - Shadow direction to goal 
You can mirror offside graphics display. Set it checked, if you want to have the 
shadowing is drawn in 'offside area'. When unchecked, the shadowing is drawn in 
'onside area'. 
- Deceleration duration 
Duration of play rate deceleration before auto-stopping at offside time. 

The editor is not modal, sou you can have an Offside product in the product bar, open it's 
style file and when you save the changes and reselect the Offside product, you'll see 
immediately the effect.  

See RAM Recorder section on how to store an offside clip for later replay. 
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Offside line also have the ability to show the distance between the player and the goal. 

This is done using the Tracab product under the offside tab. (Tracab data integration is 
required) 

 

Please refer to the Tracab Product setup section. 

 
Offside2 
A new implementation of Offside product focuses on the precision of the offside line. The 
user is required to choose the frame important for the offside situation and place defensive 
and attacking lines into the preview video. 

The Offside2 product might be disabled. You can enable it manually in the Config editor → 
Advanced tab. Find or add the 'Offside2' product entry in the Products section and 
change value of 'enabled' attribute to '1'. 
<Products>  
   <Product enabled="1" type="Offside2"/> 
</Products> 

 
Offside Workflow 
The entire workflow of the Offside2 product is split into 
three steps: 

1- Locate the offside situation time 
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After stopping the video, the Offside2 product gets selected automatically. By clicking 
mouse into preview where the offside situation happened, the Pick Frame step gets 
activated. A strip of frames shows up atop of the preview window. The center frame is 
showing the current time whereas the surrounding frames are taken from the frames before 
and after offside situation. Clicking on non-center frame seeks to a time represented by the 
frame.  

Clicking the central frame confirms the selection of the offside time and the product 
advances to the next step: 

2- Place Defender line 

 

Clicking into the preview windows places a defender line. It is possible to refine defender 
position by further clicking into the preview or by pressing and dragging the mouse. To 
provide better aid for exact placement of the line, a zoomed area shows in the preview, 
displaying the video area around the defender position. Note that the actual offside line is 
defined by the edge of the graphic line rather than its center.  
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When defender line is placed with satisfactory precision, clicking to the Attacker Line button 
in the Product bar advances to the last step: 

3- Place Attacker line 

 

Attacker line is placed in the same way as the Defender line. 
 

Offside position defined from multiple angles 
To increase the accuracy of the offside line, multiple 
angles can be used to triangulate a precise 3d point 
for the offside position.  

 

 

Steps: 

1. Select the appropriate frame of interest for the offside situation as per the above 
section for the  Offside2 product. 

2. Click the 3D button in the Product bar which enables ‘3D’ picking. Now click on a 
point on a player that is the part of the body related to the offside situation (this can 
be off the ground). For example upper body part. Note that the change here from 2D 
setup is that no line is visualized yet. Just the crosshair. 

3. Change camera angle. Either by remote controller or by shortcut toolbar. 
4. Clicks again on the same point on the player. 
5. Once clicked the offside line is visualized. The line now does not go through the 

cross hair anymore as the line is placed on the ground, but the vertical line does. 
6. Switch between the cameras shows the crosshair at the position where the user 

clicked. The position can be changed if required and the offside line is recalculated. 
7. Operator can go back to 2D anytime by toggling off the 3D button 

The above process should be used for both the attacking and defending lines and each 
have their own 3D button to activate this mode of selection. 



 

                              
 

25   |   Virtual Placement User Guide (v8.1)  

The Virtual Placement Offside Line 2 has been ratified and certified by FIFA as an officially 
approved technology to be used to adjudicate offside lines in an official officiating capacity: 

https://football-technology.fifa.com/en/resource-hub/certified-product-database/football-
technologies/offside/certified-systems/ 

Down and Distance 
Down and Distance is a product that displays Scrimmage 
and Down line in American football game.  A feather 
graphic (a label showing the play number and Yards to go) 
is optionally shown. 
 

Setup 
Start a new instance of Virtual Placement, ensuring that 
Pitch Tracking with 3 cameras or Scene Tracking with 1 camera is selected in the config, 
also the Product Down and Distance will need to be active.  
Correct Camera Calibration must be loaded (see Camera Tracking for sports). 
 
The Down and Distance product might be disabled. You can enable it manually in the Config 
editor → Advanced tab. Find the 'DownAndDistance' product entry in the Products section 
and change value of 'enabled' attribute to '1'. 
<Products>  
   <Product enabled="1" type="DownAndDistance"/> 
</Products> 
 

Setting up a new feather 
Once Virtual Placement has been started, right click in the white space above the video 
preview and you will be presented with a list of products that you can insert. Pick 'Down & 
Distance' to insert a new instance of 'Down & Distance' 
 
Predefined NFL feather textures as well as psd file are available at the Chyron Download 
Area (nfl_feathers_data.zip). 
 
NB: Your list of products will vary depending on the products that are activated with your 
licence.  
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Once you have inserted your 'Down & Distance' product, you can start the process of 
setting up the style. You will now have the 'Down & Distance' product in the product 
workspace. To setup the style for this product, right click on the product (Drawing 2: Load 
Style) and pick 'Style'. From here you can load a style that has already been created or you 
can define the style manually in the Style editor.. 

 

Once you have selected the 'Style' option you will be presented with a pop-up to handle 
the style file to the selected product. From here you have 5 options: 

1. Import – Load Style File to current product 
2. Export – Save current settings to style file 
3. Create the style manually or customize previously imported style 
4. OK – Close dialog and confirm 
5. Cancel – Close dialog and remove changes 

Import 
Importing will load a premade style to the selected product. Pressing import, will load a 
standard Windows file picker window. The style has a file extension of .fts, the default style 
is called 'down_and_distance.fts' and it is included in the football_default_data.zip which is 
available on the download area; 
 
Press open to apply the style to the product. All the different products can have different 
styles applied to them. 
 
Editing the style 
The Style editor is open with default style properties. You can begin with those and adjust 
them or customize previously imported styles .  
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Export 
Exporting will save content of the Style editor into a standalone file which can be imported 
later or transferred to another computer.  

 

Line Properties 

Fade In/Out The duration of the fade when the graphic is sent on air and removed from 
the output. This is independent for both line and feather.  

Texture/File This is the name of the file, this should be in the folder 
“C:\Users\<user>\Documents\VirtualPlacementProjects” 
.png is the suggested format, although other file types that support alpha 
channels are supported. Default texture is placed in the 
football_default_data.zip which is available on the download area. The 
texture is vertically stretched to cover the width of the football field.  

Width The width of the line in meters. 

Away/Dual Color Enables using separate color when away team is selected 

Scrimmage/Down 
line color 

These are the RGB values of each of the 3 lines. The line of scrimmage is 
always the same color, and it's possible to set the down and distance color 
to be a unique color for the last down (4th down for NFL, NCAA).  
 
Option to use Away/Dual color to use team colored lines 

Opacity Opacity of the Down/Scrimmage line.  

Adjustment Offset This value is used when the virtual line covers a 5 yard line on the field. If 
so, the virtual line is shifted by a given offset (in meters). Negative values 
mean shifting to right on the right hand side of the field and to the left on the 
left hand side of the field 

Line Over Zero value means the virtual lines are drawn from right between the side 
lines. Non-zero value (in meters) means the virtual lines exceed computed 
field border.  
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Style Editor – Feather tab, Simple mode 

Feather Text properties 

Text Text on the feather.  

Style Editor to edit text styles. 

Fade In/Out Duration of the fade effect of the text background.  

Delay In/Out The production In/Out is delayed by specified number of video fields. 
The delay is between user action to start/stop production and time when 
the production start/stop sequence is launched (e. g. delay from request 
to start production and time when the graphics starts fading in). 

Text Size Width and height (in meters) of the text on the field. 
 
Text 
Default value to the Text field  is $(DOWN) & $(DISTANCE). Fields '$(DOWN)' and '$ 
(DISTANCE)' are replaced by their real values. You can skip one of those values if desired 
or e. g. change '&' to 'and' or replace the value with any text of your choice. You can also 
use any of the available variables (see Appendix C – Application Variables). 
 
Customize Distance wording 
Distance can have special values of 'goal' (down line equals to the Goal line) and 'inches' 
(Distance is less than 1 yd). Those values can be customized using formatting options of 
the Variables. Example: 
$(DISTANCE;Goal) Change 'goal' to 'Goal' 

$(DISTANCE;Goal;Inches) Change 'goal' to 'Goal' and 'inches' to 'Inches' 
 

To edit text style simply click the Edit... button next to the Style label. A new dialog with 
editors for all available text properties appear.  
Meaning of each field is described in the tooltip is shown when you hover the mouse cursor 
on the field for a moment.  
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Using capitals 
If you want the text to be rendered in capitals, set a non-zero value to the Capitals ratio 
field. 
Zero value makes all characters keep its upper/lower case form as defined in the Text field 
in the Style editor.  
Other values cause all character to be rendered in upper case, but when the character was 
defined as lower case then this character is scaled down by the Capitals Ratio value.  
 
(e.g. set 0.7 to archive following effect: '3RD & 8'). 
 
 
Feather Texture properties 

Fade In/Out Duration of the fade effect of the feather texture.  

Opacity Opacity of the Feather texture line.  

Play Mode Used only when the feather texture is a .gtc clip. It can either loop 
from specified frame to the end of the clip or pause at specified frame. 
In Loop mode the clip starts to fade-out on user request to stop 
production. In Pause mode the clip is unpaused and plays to its end. 
Loop Start/ Pause Frame value is defined in the field bellow. 

Mode Simple – Only one texture for the feather is defined. Texture for 
opposite attack direction is simply horizontally flipped version of the 
original texture. Position on the field and text offset remains the same.  
Advanced – This mode allows to have different textures for both 
Home and Away team and for both attack directions. Correct texture 
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is chosen automatically. In Advanced mode you can setup another set 
of four textures with sponsor logos etc. During production you can 
one-click switch between these sets of Feather textures. 

Texture Define image or .gtc texture of the feather. In Simple mode the texture 
is pointing from left to right. It is horizontally flipped for the other 
direction. In Advanced mode – first row of Home and Away textures 
are pointing to the left and in second row the textures are pointing to 
the right.  

Size Size of the feather on the field in meters. 

Pause/Loop 
start 

Used only when the feather texture is a .gtc clip. Meaning of the field 
is depended on current Play Mode setting. 

�  
� Loop – the field has Loop Start label. The clip loops from here 

defined frame to the end. You can set fade-out as cut-out 
effect. 

� Pause – The clip plays and is paused at Pause frame. On cut-
out command the clip is unpaused and plays to its end.  

Position These values adjust how far in space the object should be from the 
line of scrimmage (in meters). Use negative value in x to move the 
feather to left and in y to move the feather close to the camera. 
Positive values have opposite effect. 

Text Offset These values adjust how far in space the object should be from the 
Feather texture (in meters). Use negative value in x to move the feather 
to left and in y to move the feather close to the camera. Positive 
values have opposite effect. 
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Advanced Mode

 

Style Editor – Feather tab, Advanced mode 

Additional feather text properties 

Relative 
Alignment 

Option to have text follow the alignment of the arrow. 
 
Arrow facing left text is aligned left, if sides are switched alignment 
changes to right in order for text to follow the feather direction in all 
cases. 

 

Sometimes the Simple mode is not suitable (example: different texture for each team is 
required or the texture contains text/logo, which may become unreadable when the texture 
is flipped).  Advanced mode helps in such situations. You can have different texture for 
each team and for each attack direction. These textures are rendered without flipping, so 
logos and texts inside the textures will remain readable. 

Sponsor mode allows to have another four version of the Feather texture with sponsor 
logos. During production you can easily switch Feather with or without sponsor. To enable 
this mode, simply check the 'With Sponsors' box.  
 
Meaning of all fields in Advanced mode is the same as in Simple mode. Since the textures 
must not be symmetric, you can set position on the Scrimmage Line and offset of the Text 
individually for each Texture.  
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It is necessary to have correctly set side for Home team when using Advanced mode. Use 
the arrow button in the upper left corner of the Down & Distance editor to set the side. 
Make sure the item is checked when Home team plays from left to right and unchecked 
when Home team plays from right to left. 
 

 

Changing Feather mode 
You can change the production straight from the Down&Distance product button. Buttons 
Feather production modes are visible all the time the product is selected.  

ON Show Feather.  

ON + S Show Feather with sponsors.  

OFF Hide Feather. Only Down and Scrimmage 
lines are rendered. 

 

Change of all modes can be mapped onto keyboard shortcuts in the config editor. List of 
available actions: 
FeatherOFF Hide Feather and text. Only lines are visible. 
FeatherON Show Feather.  
FeatherONWithSponsors Show Feather with sponsors.  
FeatherOnOffSwitch Hide Feather if visible or show when invisible.  
 
These shortcuts change Feather mode in all selected products.  

Changing feather position 
The feather position on the Scrimmage line defined in style might be not suitable in all 
situations (e.g. the feather collides with players). To solve such situations you can have 
several feather positions predefined and change the position by a keyboard shortcut. Go to 
the Config Editor → Keyboard tab. Add action called FeatherSetPosition. Value of the 
action is the distance of the feather from the center of the field in meters (e. g. setting -15 
sets the feather 15 meters from the field center closer to the camera).  
You can have several actions defined with various positions.  

Since Virtual Placement 7.6, it is possible to adjust feather position directly using a mouse 
or using keyboard shortcuts in user set increments. 

Using a sponsor with Down and Distance 
There are two ways to use a sponsors logo with the system. The first is to build the 
sponsors logo into the feather images. Then fill in the texture names into corresponding 
fields in the Style editor. The feathers with sponsors must not be in the Sponsors field in the 
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Style editor. You can use them in the Advanced mode without sponsors, but you will lose 
possibility to show regular feather without sponsors.  
The second method is to create a new image product and have the tracking method set to 
'pitch'. This will ensure the perspective is correct, but the logo will have to be positioned 
manually for each usage. 
 

Play Clock 
Play clock is valid between 2 plays. It shows time for 
the attacking team to snap the ball for the start of the 
next play. 
The clock must be supported by currently used 
Down&Distance protocol (see Remote data source). 
The clock from the protocol is available as variable 
named USERTIME (see Appendix C – Application 
Variables for formatting options). Down&Distance data protocol must be set as time source 
for the User time (See Installation Guide, chapter Down & Distance online data). 
 
Production of the clock is started automatically when the down-counting clock reaches 
defined trigger. 

Production of the clock is stopped manually by repressing the clock button next to the 
Down&Distance product button or toggled using keyboard shortcut SPACE. The feather 
and the lines stay on-air. 

Clock style 
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Enabled Enable the whole clock functionality 

Auto ON Clock trigger. The gfx will be shown when play clock reaches this value. 

Auto OFF Clock trigger. The gfx will be removed when play clock reaches this value. 

Color From Value for when countdown changes text to user set color and if its activated. 

Home Text Home text to display.  

Away Text Away text to display. 

Style Editor to edit text styles for both home and away team. 

Size Size of the gfx element. Size units are dependent on Mode. 

Position Position of the background relative to the feather in XYZ 

Text offset Offset of the clock text from the clock background in XYZ 

Mode Production mode.  
� Simple – 3D clock gfx element used for both teams and both attack 

directions. The gfx uses pitch tracking and is keyed. The background is 
horizontally flipped when necessary.  

� Advanced – similar to Advanced mode in Feather tab. Each team and 
each attack direction uses different background and different positioning, 
texts.  

� Advanced with sponsors – Same as advanced, used when Feather 
sponsor mode is on. 

� On Screen – 2D clock gfx on the screen at fixed position.  

Tracking Billboard or model option for play clock to be standing up or displayed on the 
ground together with the feather 

 
3D gfx elements use pitch tracking and are keyed. 

Down and Scrimmage line position controls 
The dialog is available in menu Tools → Down and Distance.  
It allows to change position of both lines and number of play.  

Remote data source 

 

Data for the Down and Distance product (positions of the lines, play number..) might be 
obtained from an online source. See Installation Guide for information about supported 
protocols and their configuration.  

Some fields might not be supported by all protocols. These need to be controlled by the 
operator (e. g. side of the field of the Scrimmage line). 
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Supported protocols don't carry information about assignment of both teams to left or right 
hand side of the pitch. The operator must set the pitch side for Home team manually in the 
menu available from the Settings button. 

In case the incoming data are incorrect or not suitable for the moment, you can anytime set 
the values manually. Once you do any manual change (or deselect the 'Auto' check box), 
the system stops using the values from the remote data source. Select the 'Auto' check 
box for transition back to automatic data reading mode. 
 
You can see the delivered data values above the edit boxes or inside the expanded menu 
(Optional).  

Value that differs from the one used for graphics rendering are displayed with highlighted 
color.  

There are two Update buttons. The upper one replaces current Down line position by the 
delivered value, the second one replaces position of the Scrimmage line. 

 
 
Fine adjustments of line positions 
Sometimes you may need to quickly make a fine adjustment of the line position.  
Using mousewheel 
Just click in the field to adjust and scroll the mouse wheel while holding the Shift key down. 
With shift key down, the scroll step is 0.1 yd. 
Using keyboard commands 
Add 0.1 yds to the scrimmage line using HOME and -0.1 yds using END on keyboard 
Add 1.0 yds to the scrimmage line using PAGE_UP and -1.0 yds using PAGE_DOWN 
50 yd Switch 
If data for down and distance is not available, users can activate the 50 yd switch for 
seamless crossing of the 50 yd line. 

 

This allows users to cross the 50 yd line without having to switch between L and R by just 
scrolling the mousewheel up to go forward and mousewheel down to go backwards on the 
field, direction of play is controlled by the arrows. 
 
Scrimmage line will never cross the down line and the tool will push the down line 10 yards 
forward automatically whenever scrimmage line hits the down line. 
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Adjust opacity of all graphics 
From the popup menu for a Down & Distance 
product pick Opacity item. Opacity editor 
appears next to the Product button. Change the 
value to change the opacity of all graphics that 
belong to the Product.  
Drag the slider to make the Feather and Lines 
more or less transparent.  
This change has a multiplicative effect on opacity 
values of all single graphics elements previously 
set in the Style editor.  
 

Different chroma keyer for Line and Feather 
From the popup menu for a Down & Distance 
product pick Keyer item. The editor that appears 
contains the following items: 
 

 
 
 
Line Key Chroma Keyer instance for Scrimmage and Down line. 
Feather Key Chroma Keyer instance for Feather and text.. 
Chroma Filter Edge aliasing filter (see Keyer and Fade). 
 

Red Zone 
Product to highlight the red zone area in American football 

 

Red Zone workflow 

1. Set where the ball is placed on the field (max 20 yd line) 
2. Activate RedZone tool, zone will by default appear on both ends of the field 
3. Set it to only be shown on Left or Right side if needed 
4. Deactivated RedZone when you want it to disappear 

RedZone Style Editor 
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Meaning of the Style editor fields: 
 
Color Set color of RedZone fill. 
Opacity Opacity of the RedZone fill texture.  
Enabled Enabling outline of RedZone tool. 
Color Set color of RedZone outline. 
Opacity Opacity of the RedZone outline texture. 
Size Size of the RedZone outline texture. 
Fade In/Out The duration of the fade when the graphic is sent on air and removed from 

the output. 
Import Import saved settings for tool 
Export Export settings for tool 
 

Field Goal Target 
Product to highlight home and away teams field goal targets in American football 

 

Field Goal target workflow 

1. Select which sides field goal target you want to display by pressing Home or Away 
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2. Set attacking direction of team selected by pressing Left or Right 
3. Activate Field Goal Target tool to put on-air 
4. Deactivated Field Goal Target tool when you want it to disappear 

Style Editor 

 

Meaning of the Style editor fields: 
 
Home/Away File Set different textures for home/away team target lines, if generic texture is 

used set same in both 
Loop Start Set start point for looping. Frames before Loop Start are played once, the 

rest of the clip loops for defined number of periods set in the Loop 
property. 

Width Width of field goal target texture (in meters). 
Opacity Opacity of field goal target texture.  
Fade In/Out The duration of the fade when the graphic is sent on air and removed from 

the output. 
Line Offset This value is used when the virtual line covers a 5 yard line on the field. If 

so, the virtual line is shifted by a given offset (in meters). Negative values 
mean shifting to right on the right hand side of the field and to the left on 
the left hand side of the field 

Home/Away Target Each team's respective target line for field goals 
Import Import saved settings for tool 
Export Export settings for tool to saved file 
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Ball speed 
This type of product is designed for measurement of ball 
speed during free kicks etc.  
The product requires pitch tracking and camera recorder 
enabled. Tracking and keying are not supported.  

Meaning of the controls shown next to the Product button: 

 

Start point not defined. Click the ball at time of the kick. 

 

Start point defined. You can still redefine position of the ball. Press RESET to 
define the Start at other time.  

 

End point not defined. Click the ball at the end of the kick. 

 

End point defined at current time. You can still redefine position of the ball.  
Press RESET to start again.  

 

Both Start and End points are defined but none of them is equal to current time. 

RESET Reset Start and End points.  
 
Ball speed workflow 

1. Add Ball speed product to the project and setup its style. Only one Ball speed 
product can be selected at a time. Ball speed products can be selected only when a 
Recorder camera is actually selected. 

2. Stop the live feed using the STOP button on the Jog/Shuttle (or use Camera button 
in the toolbar) 

3. The camera is automatically switched to recorder so you can see end of the 
recorded footage. At this point you can still switch between recorded cameras.  

4. Select the Ball speed product. 
5. Define Start point: jog back to the time where the player kicks the ball and click the 

ball in the preview.  
6. Define End point: jog to time where it is desired to stop the measurement (e. g. the 

ball leaves the field). Click the ball position on the ground. In case the ball is in the 
air, click approximately the point below the ball on the field.  

7. Now cue back in the recorder footage where the video playback should start.  
8. Press GO/ON-AIR button to start production. 
9. Press Play button to start playback.  
10. The graphics production starts certain number of video frames/fields prior to End 

point (see Fade In Delay in the Style editor). 
11. The video might at End point (see Auto Stop in the Style editor). Press Play button to 

continue playback.  
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12. The graphics production ends certain number of video frames/fields after the End 
point (see Fade Out Delay in the style editor) or manually by unpressing the GO 
button. 

Style editor 

 

Meaning of the Style editor fields: 
Texture Background image/gtc clip below the speed text 
Texture/Text Size Size of the background [as a percentage of the screen] 
Texture position Background position [as a percentage of the screen] 
Fade Fade in/out [in frames/fields] 
Text Offset Offset from the background [as a percentage of the screen] 
Text Delay In The text production is delayed by specified number of video frames/fields 
Text Delay Out The text production cut-off is delayed by specified number of video 

frames/fields 
Text Text formatting string 
Text style Open Text style editor by the 'Edit...' button to modify the style (color, 

alignment...) 
Auto Stop When checked, the video playback will stop at End point of the kick. 

Press Play button to continue video playback.  
Fade In Offset Production start is computed from End point of the kick. Fade In Offset 

defines how many video frames/fields the production will start prior to End 
point (e. g. value 50 will start the production 1 second before the End 
point in 50 fps video format). 

Fade Out Offset Production end is computed from End point of the kick. Fade Out Offset 
defines how many video frames/fields the production will end after the 
End point (e. g. value 50 will end the production 1 second after the End 
point in 50 fps video format). 

 
 
Text Formatting 
Some graphics can contain a text field. There are values provided by the application that 
can be used in formatted string. See table of all supported variable names on page.  
 
The format string is compatible with ANSI C printf() function. Example: 
● %MPH$.1f – picks value “Speed in miles/hour” and uses one decimal point e. g. 

'53.2' 
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● 'Speed: %KMH$.0f km/h' will be transformed to e. g. 'Speed: 53 km/h' 
 
Supported value names 
 
KMH Speed in km/h 
MPH Speed in miles/h 
MS Speed in m/s 

 
 

Events 
An event is being sent every time the ball speed changes: 
<Event app="VP" source="BallSpeed"> 
  <BallSpeed value="12.18691"/> 
</Event> 
 

Group 
Group is a generic product which 
contains multiple child products, and 
allow you to control multiple products by 
a single click. Group can contain only 
Images, Clips, Video Inputs and Text 
products.  

Create a group using menu Insert → 
Group. A button with folder icon (1) 
appears in the product bar. At this time 
the group is still empty. You can add 
product into a group in two ways.  

1. Move an existing product to a 
group. This can be done via Move 
to Group popup menu on group-
compatible products (Image, Clip, 
Text, Video Input). 

2. Use the popup menu on Group button, submenu Insert. 

Remove or move-out one of child products can be done from the popup menu of the group 
button.  
Group button contains small buttons (2) for each contained product. The button can be 
used to adjust product specific parameters, like e. g. Color Correction. It can be done in 
very similar way as described above in the Products section.  
 
Adjust Position and Size 
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Hit the group button. All products appear on the screen. Adjust all products in the way 
described a few paragraphs above.  

Adjust Child Order 
If children products overlap, you can change the order of display from the child popup 
menu (3), using the item Arrange.  

Make a Child Invisible 
When a child is invisible then it is neither visible in the preview or on the output.  
Group can be used for more complicated production scenarios. You might find useful to 
hide all but one selected child. This function is in View menu in the application menu bar,  

item “Show Only Selected Child”. This hides the children from preview only. When you put 
the group to on-air then all children appears again (this functionality is turned off). 

Show/Hide Child buttons 
Each time the group is selected, the panel with child buttons appears. There is a switch to 
enable/disable automatic displaying of the child buttons. The switch is controlled by the 
small button with arrow icon in the lower right corner. 

Sponsors 
Products Offside and Free Kick allow to show additional graphics - sponsors. As a sponsor 
you can assign basic products like Image, Clip, Text or Video. Each sponsor can have it's 
own individual tracking. 
There are two main stages for operating sponsor: 

1. Editing stage 
2. Production stage 

 
Do not combine editing and production at the same time! Sponsor must not 
appear on-air. We recommend you not to operate in the sponsor editors 
during production.  
 
Sponsor Editing 
Editing stage serves for initial positioning of sponsors. Select one of the sponsors in the 
Sponsor editor. 
FreeKick – you can see the sponsor immediately . 
Offside – you will be guided to place the offside line first. System automatically chooses 
playback of one offside cameras. Now you can see the selected sponsor.  
 
Sponsor Production 
Production stage serves to put sponsors on-air. This stage is the same as regular 
production without sponsors.  
 
FreeKick 
Production start : Sponsors are shown immediately after you press the GO button.  
Production end: Sponsor production is finished together with FreeKick. To finish production 
press the GO button again.  
 
Offside 
Sponsors are bounded the time you place the offside line.  
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Usual offside workflow: Press STOP on remote control device.  Go back in footage (preroll) 
and then press PLAY on remote control device.  
Production start: Sponsors appear automatically in defined time before offside line appears. 
Production end: Finish the production by one of these methods: 

● setting of finite duration to the sponsor products (see Duration editor chapter) 
● deselect Offside product (ESC key) 
● switch camera.  

Otherwise the sponsor production runs until you perform one of these actions.  
 
Insert Sponsor 
Sponsor actions are accessible via Sponsor menu items in the Offside/Free Kick popup 
menu. To add a sponsor, choose Insert Sponsor action. Select type of product you want to 
add. 
 
Sponsor Editor 
The Sponsor Editor is similar to Group children editor. From the popup menu of each 
sponsor you can access property editors, that are accessible in normal 
Image/Clip/Text/Video products (Color Correction, Tracking etc.).  
Moreover, after Sponsor selection (1), Sponsor Property editor gets accessible (2). The 
editor offers few choices related to sponsor production only.  

 
Visible – Says if the product should take place in the production. The item is useful, when 
you want to prepare for production of several sponsors, each at a different time. You can 
adjust all properties, and during the match just toggle the Visible flag to change actual 
sponsor, without need to adjust it's parameters during the match.  
Relative Start – for Offside only (not accessible for Free Kick). For timing of production 
relative to time (in field units), when the offside line gets visible. To display sponsor 50  
fields before the offside line starts to fade in, set “-50” to the edit box.  
Placement – Offers automatic choice of area, where the sponsor will be displayed. 

PRESERVE No automatic placement. The sponsor appears where you place it. 
In case of Offside and tracking Pitch, Billboard, Billboard Facing: 
Sponsor holds relative distance to offside line. Position is horizontally flipped 
based on pitch side where is sponsor placed.  
Example: Sponsor is kept between offside line and the goal all the time, pitch-
side independent. 

SUITABLE Tracking None 
Automatic left/right hand side displacement. The system decides where to place 
sponsor to avoid collision with Offside/FreeKick graphics. It uses Horizontal 
flipping method (applied to position of the sponsor only, the logo is naturally not 
flipped) to avoid collision.  
Example: You set sponsor to upper right corner of the video and choose 
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SUITABLE placement type. If the Offside/FreeKick graphics is on the right hand 
side of the video, the sponsor is displayed in the upper left corner and vice versa. 

LEFT_SUITABLE Tracking None 
Similar rules as in SUITABLE are used. The system doesn't choose side, but 
whether to display the sponsor or not. If there's possibility of collision, the 
sponsor stays hidden. If collision is not detected, sponsor is displayed at left 
hand side (where you place it). 
Example: You may want to display sponsor either in upper left or lower right 
corner, collision-safe. Add two same sponsors, place them to desired places, 
distinguish them by the Placement property.  
In case of Offside and tracking Pitch, Billboard, Billboard Facing: 
Shows sponsor either on desired side or not at all. 

RIGHT_SUITABLE Opposite to LEFT_SUITABLE. 

ROTATE_180 Only for Offside and tracking Pitch 
Very similar to SUITABLE. Moreover, the sponsor is rotated 180° 
counterclockwise when is automatically placed on the opposite side. The goal is 
to keep specific sponsor human readable.  
Example: You may have a sponsor with human-readable content. This choice will 
help to keep it readable.  

FOLLOW Only for FreeKick 
Enables following the ball position. You can change relative sponsor offset to the 
ball position by moving the sponsor. Change tracking causes sponsor re-
arranging to the ball position to help user to set nice initial position. 

 
Allowed combination of placement and tracking 

OFFSIDE 

Placement 
Tracking 

PRESERVE SUITABLE LEFT 
SUITABLE 

RIGHT 
SUITABLE 

ROTATE 
180 

NONE yes yes yes yes no 
PITCH yes no yes yes yes 
BILLBOARD yes no yes yes no 
BILLBOARD 
FACING 

yes no yes yes no 

 

FREEKICK 

Placement 
Tracking 

PRESERVE SUITABLE LEFT 
SUITABLE 

RIGHT 
SUITABLE 

FOLLOW 

NONE yes yes yes yes yes 
PITCH yes no no no yes 
BILLBOARD yes no no no yes 
BILLBOARD 
FACING 

yes no no no yes 
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Script 
Script product allows to delegate functionality of a product to custom JavaScript code. For 
example external Prime Engine can be used to render the product. 
 
Creating Script product 

● Choose new "Script..." product and select your .js file. 
● New JavaScript product appears in product bar. 
● At this moment the script is not loaded. Script is loaded/reloaded when product is 

selected/reselected. 

Predefined objects and their method summary 

Script 
   print(Object object) Print value of the object to standard output. 
   printErr(Object object) Print value of the object to error output. 
   connect(Dispatch source, 
Dispatch sink) 

Register callback. Sink object will events from 
source connection point. 

   getGlobal(String name) Return global object with given name or null. 
   setGlobal(String name, Object 
object) 

Set global object under given name. 
It is possible to delete global objects by choosing 
Tools → Delete global script objects. 

getService(String name) Return service object or null if service does not 
exist. 

dialog Dialogs provider, see Dialogs bellow 
 

 
Product  

setOnAir() Start production. 
setOffAir() End production. 
setOnAirUnpaused() Unpause paused product. 
setThumbnail(String 
absolutePath) 

Set thumbnail of the product button. 
Optional, product button has default thumbnail. 

getName() Returns name of product. 
control Handler for incoming events. Implementation is required 

to be set, see example below. 
 load() Called after product is selected. 
 unload() Called before product is deselected 
 play() Called to start production. 
 stop() Called to stop production with fade out effect. 
 stopImmediately() Called to stop production without fade out effect. 
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 unpause() Called to unpause paused product. 
 
 
Dialogs 

� message(String title, String text) Show message dialog. 
� input(String title String text) Show input dialog. Returns entered string 

value. 
� alert(String title, String text) Show alert dialog. 

 
Product.control implementation is required and must be set. See this stub: 
Product.control = new function() { 
    this.load = function() {} 
    this.unload = function() {} 
    this.play = function() {} 
    this.unpause = function() {} 
    this.stop = function() {} 
    this.stopImmediately = function() {} 
} 
 
ActionBox service 
Creates action buttons next to product button firing events to script. 

 

add(String actionId) Add new action. Title is the same as actionId. 
add(String actionId, String title Add new action. If action with given actionId 

already exists, its title is changed to new one. 
remove(String actionId) Remove action. 
removeAll() Remove all actions. 
onAction Handler for receiving action events. Assign a 

function of object. The function receives 
actionId as a parameter. 
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Example code: 
var actionBox = Script.getService("ActionBox") 
actionBox.onAction = function(actionId) { 
    // handle action 
} 
actionBox.add("a1", "Action1") 
actionBox.add("a2", "Action2") 
Result: 

 

Script editor 
Virtual placement contains built-in editor for script files. 
Editor can be opened by clicking on “Edit script...” item in popup menu of the product. 

        Save to file and apply it. It re-selects the product if already selected. 

        Save to file. 

 Show find dialog. 

        Show find and replace dialog. 
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        Show shortcuts dialog. 

 
Script editor performs syntax validation. Syntax errors are displayed in tooltip when you 
place mouse over the red underlined text. 

 

Prime Engine integration 
There is a build-in support for GS2 Tk5. You can configure several title manager instances 
in config editor. All these instances are then injected into script as global variables. 
 
Config XML fragment: 
<Tk5> 
  <TitleManager name="GS" address="localhost"/> 
</Tk5> 
 
The name attribute is the name of variable in the script where the title manager will be 
available. 
When the address is not specified then Tk5's default is used. It is possible to have more 
than one connection to Prime Engine 
 
Script can use standard COM event/sink mechanism to get events generated by Tk5. Use 
function  Script.connect() to connect your event sink (implementation which receives 
the events) to event source (object which can generates the events). Example how to 
register onMessage event sink: 
 

function MyCallbacks() { 
    this.onMessage = function(msg) { 
        // handle message 
    } 
} 
Script.connect(GS.getClient(), new MyCallbacks()) 
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Tracab Script 
This type of product is based on Script product and provides extra access to Tracab 
service. This service is accessible via Script.getService("Tracab") call. 
 
Tracab service 

getTeam() Return selected team. 
getSelectedPlayersCount() Return selected players count. 
getSelectedPlayerTeamId(int index) Return team ID of player at given index. 
getSelectedPlayerJerseyNumber(int index) Return jersey number of player at given index. 
getData(int teamId, int jerseyNumber, 
String attributeName) 

Return attribute value of player specified by 
given team Id and jersey number. If player is 
not valid or value does not exist null is 
returned. For attribute name syntax see 
Variables section in  Tracab Player Tracking 
chapter. For example 
TRACAB:myVariable. 

onChange Handler for receiving selected players change 
event. Implementation example bellow. 

 
Example 

var tracab = Script.getService("Tracab")   
tracab.onChange = function() { 
    // handle event 
} 
 
 

Trajectory 
Creates keyframe-animated trajectory, following e.g. ball.  

To create a trajectory product, a Trajectory Style file (.trs) has to be provided. Default .trs 
file is available on Download Area, packed into the default_data.zip archive. 

To start keyframing a trajectory, enter recorded camera or clip. After selecting the product, 
locate the tracked object in video and click on it. A manipulator shows up. By jogging 
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forward and moving the manipulator, a trajectory animation is being keyframed. It is 
possible to jog back and refine the animation when needed. 

Trajectory product button provides additional buttons for moving to previous/next closest 
keyframe, for removing all keyframes or for removing keyframe at current time. 

The Trajectory product might be disabled. You can enable it manually in the Config editor 
→ Advanced tab. Find the 'Trajectory' product entry in the Products section and change 
value of 'enabled' attribute to '1'. 

<Products>  

   <Product enabled="1" type="Trajectory"/> 

</Products> 
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PRODUCTION 
Select desired product (or multiple products with ctrl key down). Press the GO button. All 
selected products appear on-air  (start to fade-in if defined). 

Production is stopped 

● Automatically – when the product has finite duration – either clip without infinite 
loops or pause points, or other products with user predefined duration. 

● Manually – press the GO button once again.  
○ Products with out-animation start to animate out. 
○ Products with fade-out start to fade-out. 
○ When there is a paused clip in the production at its last pause point, it is 

unpaused and  animation-out and fade-out of other products are scheduled 
so they finish production at the very same moment as the clip. 
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MULTIPLE CAMERAS 
Virtual Placement allows usage of more camera inputs/outputs. Multiple cameras can be 
disabled in configuration file. Make sure, the camera I/O settings are properly configured. 
Configuration is described in the Installation Guide document.  

You can switch between cameras using the camera selection menu in the application 
toolbar. Also you can assign Jog/Shuttle controller buttons to perform camera switch (more 
about action assignment in Function Assignment Customization section.) 
 

Single channel rendering 
Graphics is rendered to one camera only. Graphics with tracking set to Screen are rendered 
to actually selected camera stream. Graphics with other type of tracking are rendered to the 
camera stream which had been selected in time the Product was selected.  

Multichannel rendering 
Graphics are rendered to all camera streams. Supported tracking types are Scene, Pitch, 
Billboard and Billboard Facing. Products using other type of tracking are rendered in one 
camera only.  
Objects on the pitch are rendered in correct perspective in each camera stream.  

This enables the user to apply graphics to each camera in order to then switch between 
views and still maintain the graphics on each camera output. 
 
Multichannel rendering is disabled by default. You can enable rendering to multiple parallel 
streams in the Config editor (use corresponding configuration preset) 
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MULTIPLE CAMERA OUTPUT 
Virtual Placement has the ability to take a single video source in and then output multiple 
feeds with different graphics on each output. This workflow enables virtual graphics to be 
targeted to a specific region or platform.  

To enable multiple outputs within Virtual placement, launch the  configuration editor and 
select the video tab. 

Configuration for multiple outputs is supported on either one or multiple I/O cards. 

A drop down menu is available by clicking the on the Field under the card that you want to 
assign the output too. 

 

Within Virtual placement select a product  that you want to assign to an output channel. 
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The user is then able to assign the available output channels to each product. Virtual 
placement has the ability to assign multiple products to one channel. 

 

The available channels will be listed beside each product.  

Once assigned the user is able to switch output channels within the Virtual Placement 
preview window in order to see which graphic is being displayed. On each of the individual 
channels. 

 

Multichannel rendering 
Graphics are rendered to all camera streams. Supported tracking types are Scene, Pitch, 
Billboard and Billboard Facing. Products using other types of tracking are rendered in one 
camera only.  
Objects on the pitch are rendered in the correct perspective in each camera stream.  
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CAMERA TRACKING FOR SPORTS 
Generally, tracking means that when you place a product to a certain place (e. g. center 
ellipse of the pitch), it will stay there, no matter where the camera looks. It can also be out 
of view range. On the other hand, a non-tracked production will stay on it's place relative to 
the screen (e. g. always in left upper corner of the screen). When you have tracker product 
for virtual production, it will automatically correct perspective without need to set the 
perspective „by-sight“. Just set position.  

You may ask, how the tracker knows where the pitch is and which direction the camera 
moves. That's why we have to calibrate the camera first and determine the relationship 
between the pitch and the camera. Once the camera is calibrated, the tracker continually 
recognizes actual camera parameters. As we know the position of the pitch in every 
moment, you can set up and run production by a few mouse clicks. Everything necessary 
has been already prepared for you in the background.  

Once the calibration is done (follow the Camera Calibration section), you can save it to a 
file. It is not recommended to use older calibrations (from a previous game) for the next 
match at the same stadium as the probability that all the cameras are at the very same 
position is very low. In case the cameras are located on a movable spot (lifting floors etc.), it 
is recommended to watch camera positions during the match (especially before games and 
after breaks). If a camera position changes and the tracking quality is poor, you may have 
to recalibrate the concerned camera. We recommend being ready for such situations 
(especially in the case of cameras on lifting floors) and let the camera operator know you 
may need his assistance short before the game.  

Last used calibration is automatically loaded after the application is started. In case of 
system restarts, you do not have to load it manually. Actually loaded calibration is displayed 
in the application title bar.  

Calibrations are saved with current video setting context. You cannot load calibration 
previously done in different video format. 

Virtual Placement is designed to be used in various workflows from upstream to 
downstream productions. This provides greater flexibility during the production workflow, 
Pitch and Scene tracking support the downstream workflow. The downstream workflow 
provides the user with the ability to take a clean or program feed with the various camera 
angles, and then apply the appropriate graphics to each angle. 

There are several options for downstream workflow to suit different infrastructure setups. 

● MODEM - An upstream Virtual Placement calibration is embedded in an audio 
channel and read by downstream Virtual Placement instance 

● VANC - Where upstream Virtual Placement calibration is embedded as vertical 
ancillary data (VANC) and read by downstream Virtual Placement instance 

● GPI TONE - A downstream instance of Virtual Placement analyses a spare audio 
channel where the GPI trigger is present 

 
Note: Downstream workflows require a license. 
 
For more information on downstream workflows please contact 
Sports_Product@Chyron.com  
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PITCH CALIBRATION 
 

Camera Calibration 
Camera calibration feature for sports is optional. It is available only if you have a 
license for this feature. 
 

For precise tracking and product placement in correct perspective you have to calibrate 
cameras. You can get to the calibration dialog using calibration button in the toolbar. 
Calibration dialog appears in the Product bar. 
 

Open existing calibration  
If the cameras have been calibrated already for the particular stadium and the calibration 
has been saved, you can just load it using Open command from the Calibration bar or 
Calibration menu. It is strongly recommended to verify the match of the existing calibration. 
Go through the calibration process straight to the verification part and follow the instruction 
in the verification section. 
 
Create new calibration 
Select New calibration from the calibration editor or Calibration menu. Select the 
appropriate pitch from the available types.  

 
Soccer - Suitable for main and offside cameras. 
Tracks all pitch lines.  

 Football  
license 

 
Soccer center - Center camera can be tracked with 
only central part of the pitch. The calibration is much 
easier then in the full soccer pitch. 

 Football  
license 

 
Tennis - Suitable for camera behind base line.  Tennis  

license 

 
Badminton pitch - Suitable for camera behind base 
line. 

 Tennis  
license 
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Rugby League - Wide and middle zoom cameras are 
supported. Tracks all pitch lines. Beware this pitch is 
not compatible with Rugby Union. 

 Rugby  
license 

 

International Rugby (Rugby Union).   Rugby  
license 

 

NFL – American Football. The field is NFL approved.  Rugby  
license 

 

NCAA – American Football. The field is NCAA 
approved.  

 Rugby  
license 

Calibration 
For all cameras do following (1): 

● Capture Frames 
● Define Line correspondences 
● Set Pitch Color 
● Configure Active Image Area 

And follow with steps common for all cameras (2): 

● Calibrate all cameras at once 
● Define pitch borders (not available for all pitch types) 

When the first step is done, press the Calibrate button. The calibration engine calibrates all 
cameras at once. When the calibration succeeds, and you are satisfied with the result, 
press Done button. You return here and continue with borders definition (Borders button). 
 
Capture frames for calibration 
There are several screen previews in the list (1). Go through the list, move the camera and 
find shots as much close to the ones in the list as possible. Every time you find 
corresponding angle of view from the camera, press the Capture button (2). Small camera 
in the corner indicates the frame has been captured successfully. After capture verify 
quality of capture frame. In case the frame is blurred, drop the frame using the Remove 
button (4), which appears after the frame was captured.  You don't have to keep order of 
frames given by the preview images. 
After all frames has been captured, press the Done button to proceed back to camera 
selection and following calibration phases.  
Generally not all presented views must be captured. Higher number of corresponding views 
will give you higher probability of good match and better tracking quality.  
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Line calibration 
Select a line (point) in the model (1) and draw corresponding line on the pitch in the video. 

The most important lines for each frame are drawn in white color in the model (1). Make 
sure, all important lines are calibrated. In case of the unimportant lines, higher number of 
definitions implies lower probability you will have to return and correct them. But it is not 
necessary. 
It can happen, only part of a line is visible in the video frame. In this case just draw line in 
the video for the visible part of the pitch line. Don't skip it.   
Actually selected line is red colored in the model. Repeat calibration step for all previously 
captured frames. 

 

To go to next frame, press the Next Frame button. You can delete already defined 
lines/points  from the pop-up menu above the model pitch resp. To remove all lines at 
once, there's 'Remove all' function accessible from popup menu triggered outside any 
pitch line/point. You can also redefine any line. Just select the line in the model, it appears 
in the video and draw the line again on the desired position. When you're done, press Done 
button and return back to the main stage.  

How to draw calibration lines over pitch lines 
The calibration line should be as close as possible to the real pitch line. The length of the 
calibration line does not necessarily be the same as the real line. Because of camera lens 
distortion and pitch curvature the lines in video are not straight. It is therefore sometimes 
impossible to draw the calibration line to exactly match the pitch line. In this case try to 
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draw the line shorter in the middle, most straight segment of the real line. See following 
examples: 

This picture demonstrates wrong calibration line. The line on the sides does not match. 

 

This picture demonstrates wrong calibration line. The line in the middle does not match. 

 
This picture demonstrates proper calibration line. It is shorted but matches the pitch line 
well. 

 
American Football Point correspondence guidelines 
Calibration of field for American Football (NFL, NCAA) needs certain points 
correspondences to be defined. These points are located at intersection of the solid 5 yard 
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lines with 1 yard hash marks.  
 

Sidelines 
Sidelines for American Football and similar fields that use very thick Sidelines need the 
calibration lines to be drawn over the inner side of the pitch line. Example: 

 

Good Bad 

  
 
Image correspondence in soccer center calibration 

The soccer center pitch has very simplified calibration. Because the amount of information 
that can be extracted from the image is much lower than in normal soccer pitch tracking, 
extra attention must be paid during the calibration. 
 
To calibrate it properly, please follow these rules: 

● The center line must always be calibrated. If the line is curved in the image (due to 
the lens distortion or pitch curvature) then it is better to draw the line closer to the 
center then to line ends in the image. 

● At least one horizontal pitch edge line must be calibrated. Either the top or bottom. 
There are four points in the UI  for the center circle. You must calibrate all of them. It 
is important to place the points on the circle in the image. It is not so important 
where on the circle the point is. It just needs to have 4 points on the circle roughly 
equally spaced.  
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Calibration of pitch grass color 

Correct setting of the pitch mask is very important for correct functionality of the tracking. It 
is fully independent on the chroma keyer used for graphics insertions.  

1. Set the pitch mask color to fit the grass color. You can do it from live input or from 
images captured in previous step (Capture images) 

2. Check the mask periodically during the game. When the light conditions change, 
alter the mask to fit actual pitch color.  

3. Check the mask when the tracking becomes inaccurate. 

You are allowed to adjust only Hue/Saturation. Change those values until you find good 
result for all examined images. Suitable pitch mask is shown in the picture below. 

Calibration of active picture area  
In case, the input video contain black border or any mess, don't forget this step. Otherwise 
the black borders can negatively influence tracking quality. 
Get to the active area calibration from cameras panel. You can see a rectangle enclosing 
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the whole video area. Drag the four draggers (1) in the middle of each side so the rectangle 
covers only active area. Black borders (2) are drawn with hatched-pattern. 

Calibration 

When all the camera-wise steps are done, for all cameras you wish to be tracked, continue 
to the calibration process.  

 
 
Screen with calibration progress appears. 
The duration of calibration process depends on number of calibrated cameras and pitch 
type. It could be from 5 seconds to 3 minutes. 

 
  
  
  
  
  
 

 
Verification of the result 
Go through all frames of all cameras using the Navigation panel (1) in the list and check the 
quality of the match between computed and real pitch lines. Computed lines are shown in 
the video yellow colored.  If this happens or quality of match is poor (computed lines don't 
fit the real ones), go back to the previous section “Calibration” using the Repair button (2) 
and redefine the correspondences. In case the calibration cannot be computed for the next 
set of correspondences, try to recapture the problematic frame.  
When the calibration results match, press the Done button to go to the main stage and 
continue with border calibration.  
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Calibration of pitch borders 
This stage gets enabled after successful calibration.  
The border calibration is made on pitch top-view, which is generated during the calibration 
from the captured images. You can also see the result of the calibration, yellow pitch. This 
pitch should fit the real pitch lines.  
The pitch area, beyond the lines, can contain some additional advertisement or other 
objects like roof of the substitute bench etc.  
 
How to calibrate pitch borders 
This step is for the camera tracker to let it know where to look for pitch lines. Define the 
border on the edge of pitch grass. Don't follow the pitch lines. If any advertisement lies 
between the pitch line and the grass edge, draw the line between the pitch line and the 
advertisement.  
Properly defined grass borders are very critical when the lines are badly visible. Please have 
a look at the picture below to learn how the borders should be well defined.  
 
In the pitch-side selector (1) select area containing such objects. Draw a line in the video 
between that object and pitch line (2). Switch area (1) to define borders for other sides. 
Repeat for all cameras.  
 

Basics of the line painting mechanism: 
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Define new line Simply draw a pointed line. 
Extend existing line Click on one of the end points and continue with the line. 
Change shape of existing line Select point on the line and move the point. The line is divided 
Remove existing line Drag the end point above the start point and release the 

mouse. Or use clear function from the pop-up menu on the 
area buttons (1). 

Finish existing line Click on the end point. Or change border area (1). 
The result should like shown on following picture (the red lines). 

 

 

 

Good and bad practices in calibration border 

 

BAD 
The line too close to the side 
line. There is no reason.  

  

GOOD 
Make the line as far as 
possible from sideline 

  
 
 

BAD 
Do not try to follow the 
missing part of the pitch. 
There is nothing wrong with 
the pitch, you just don't see 
it. 
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GOOD 
Do not make the border or 
make your guess what can 
be there. It is better not to 
have border then to have 
wrong border. 

  
 
 

BAD 
Calibration is not accurate. In this case 
some part that lies outside the pitch is 
projected into the pitch. Do not try to 
cut off this bad projection.  

 

 

GOOD 
Make you best guess where the 
advertisement ends and where the 
grass begins. Put the line as close as 
possible to advertisement and as far as 
possible away from pitch. 
 
 
 

 

 

BAD 
The advertisement is cut off but you 
cut off too much.  If you cut it off the 
tracker will not be able to find the pitch 
line and the tracking quality will be 

GOOD 
Cut off only the part that is close to the pitch. In this 
case there is only a small banner that can confuse the 
tracker. Cut off the banner and keep the grass as much 
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lower. as possible.  

BAD 
Do not cut off green pitch when there 

is nothing wrong there. Camera tracker 
is reluctant to look for the side line 

because the calibration tells it there is 
something there. 

GOOD 
Keep as border as big as possible. In this case the 
border line can be moved altogether. There is no reason 
to define it. 
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Semi-automatic Pitch Tracking 
Sometimes can happen, the tracking gets lost. It might be caused by badly visible lines, the 
camera must not have any line the current view etc. Nevertheless Virtual Placement allows 
you to work with products localized on the pitch in such situation as well. If you reach any 
scene, where the tracking is lost or incorrect, simply switch to the semiautomatic tracking. 
This correction is very fast. 
 
Starting Semi-automatic Tracking 
This type of tracking is started by definition of the first point. You can use points shown in 
the following dialog. The points in the video are selected by 
the right mouse button. You can do that anytime you want, 
when a valid camera calibration is loaded.  

1. Select with right mouse button a point in the video, 
corresponding with one of the points shown above. 
The Point Correspondence dialog is displayed. 
Select the same point in the top dialog. 

2. You should see yellow pitch on the top of video, 
showing the computed position of the pitch. If it approximately fits the pitch, you 
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can set the product and begin with production. If not, repeat step 1 for one more 
point. 

3. The tracking is set, adjust the product and put it on-air.  
4. When the production is done, you must manually switch back to the automatic 

tracking. You can do that by pressing the semi-automatic button in the toolbar, 
which is flashing during the time, when semiautomatic tracking is on (1).  

5. Anytime you want to use the semi-automatic tracking again, just begin from 1. 

As you can see in the following picture, two points should be enough to define the pitch. 
Semi-automatic tracking is designed for short productions (like free kick) and might get 
inaccurate after longer time. 

 

Don't forget every time after productions switch back to the automatic mode.  

Control of the semiautomatic tracking is designed for very fast use. The graphic operators 
will master the setting very quickly and will be able to prepare the production within 3-4 
seconds, even when the tracking gets lost.  

Tracking status 
During production you can oversee the current tracking status. The tracking results 
depends on video quality, lines visibility and calibration quality. The status is just an 
indicator for operators. Most of the time the tracking should be good. Actual tracking status 
is shown for each camera. Order of the cameras is same as in the Camera button popup 
menu. If a Live camera is selected, the info is shown for all live cameras. If a Recorder 
camera is selected, info for Recorder cameras is shown.  
 
The tracking status has following states: 
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Fail = No tracking, the system cannot recognize the pitch. You cannot place any    objects 
on the pitch. 

 
Weak = Pitch was recognized short while ago but is not recognized now. The system tries 
to recover in the background. The tracking quality may vary is this state. It is acceptable to 
have this tracking state for short periods of time. 

 

Good = Pitch tracking works reliably.  You should see this status most of the time during 
production. 

 

Semi = Semi-automatic tracking. To disable it,select „rescue circle“ button on the toolbar. 

 

N/A = Tracking information is not available.  

Display tracking result 
All the time you can see the actual state of the tracking. Press the Show pitch button. The 
system draws pitch lines to the video (to preview only, video output 
not affected). Those lines should fit the real pitch lines. Displaying of 
the tracking result can be disabled by clicking the Show pitch button 
again. 

Pitch color 
When you choose “Display tracking result”, it may happen the lines might be poorly visible 
due to color conflict of the lines and the real environment (real pitch color). You may change 
the color of the drawn pitch outline in main application Menu → View → Pitch Color.  
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SCENE TRACKING 
Scene tracking is very similar to Camera Tracking for sports. It allows you to put Products 
on the pitch. The system keeps it on the same place while the camera moves.  
Unlike Camera Tracking for sports, Scene Tracking is more universal type of tracking, but 
requires certain knowledge of the field to be provided by the user during calibration.  
 
Scene Tracking requires license.  

Calibration Editor 
 

Press the Scene calibration editor button in the toolbar to open/close the editor.  

 

Initial screen of the editor 
New – creates new Scene calibration.  
Open – opens an existing scene calibration. Scene calibration files have .scal suffix. 
Calibration folder is accessible via Start → Virtual Placement → App Directory → Scene 
Calibrations.  
Edit – edit current calibrations. 
Save/Save as – save current calibration into a file.  
 
Panorama Calibration 
Scene calibration consists of a 
Panorama and Metric. Metrics 
definition and calibration need 
the panorama to be built first.  
Press Capture button to go to 
Panorama Sweeps screen. 
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Panorama Sweeps 

This screen shows list of captured sweeps (represented by thumbnail of their first frame). 
Selected sweep is displayed in bigger size.  

 Add new sweep. This will take you to the Panorama Sweep Capture screen.  

     Select next sweep. 

         Delete currently selected sweep. 

 Generate panorama and go back to the Panorama Calibration screen. 
Panorama generating might take a while.  

Panorama Sweep Capture 
This screen will help you to setup 
the camera and get ready for the 
next sweep capture. 

Start capturing sweep.  

Go back to Panorama Sweeps screen. 

Preview of camera zoom for this sweep. The preview is shown on the SDI output 
only, so the camera crew can see the requested zoom level.  
The button is not present during the first sweep, since the camera is required to be 
zoomed-out to its maximum.  

Guidelines for sweep capturing 
� Zoom out the camera to the maximum for the first sweep 
� Point the camera at the finish line or other significant point close to the camera. 
� Start capturing sweep.  

� Don't change zoom level during the sweep. 
� Follow the track with the camera.  
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� Keep the track focused during the sweep. 
� Make sure there's no motion blur – when the light conditions are poor, make 

sure the pan is slow. 
We recommend to make the camera pan in counter clockwise direction.  
When you return to the point where the pan started, press the Finish button. 
Repeat the capture sweep procedure for another zoom level.  
All sweeps should start at the same point. 
When zoomed-in, we are more interested in advertisement and similar significant objects 
rather than mud/grass on the track.  

 
We need a minimum of 5 sweeps with different zoom settings, and as many as are 
necessary to cover the range from max zoomed out to as tight as you would want 
to go with virtual graphics. 
 

Panorama metric 
The metric contains real world coordinates of few significant points and images of 
placement of these points. The metric can contain wire-frame model of the track. 
By default, the calibration contains empty metric 

• Import – Import metric from a file (.met file). 
• Export – Export metric to a file. 
• Edit – Edit current metric. Go to the Panorama Metric Designer screen. 
• Calibrate – Calibrate the metric. Available only when a metric has been defined.  

Done – Return back to the Panorama Calibration screen. 

 

Panorama Metric Designer 

 
This screen helps you to design metric for the environment.  
It contains following controls: 

 

Model preview. When a wireframe for the model has been imported, top view of the track is 
shown.  
Additionally it contains all added model points. The points are clickable so you can verity 
their location in the video preview.  
Currently selected point is displayed in red. 
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Add a metric point. Define its position in the Model point editor. 

Remove currently selected metric point.  

 

Model point editor. Shows real world coordinates of the point [in meters].  
Coordinate system origin is user-selectable (e.g. middle of the track, finish line etc.)  
X,Y coordinates are on the surface of the environment, Z coordinate means altitude above 
the ground.   

 

Point preview in the template image. You can change detail of the view by the Wide and 
Detail buttons. 

Import wireframe from a file.  

Finish metric definition and go back to the Panorama metric screen. 

 
 
Wireframe 
We accept .svg or .obj files with the wireframe model. SVG files can be used for planar 
models whereas .obj file format allows to define 3d wireframe models. Scale of the 
wireframe model must correspond to the real-world environment. Origin of the wireframe 
model must correspond with the origin chosen for the metric points.  
The wireframe serves for visual verification of the calibration quality only. It is highly 
recommended to have a simplified model the environment.  
 
Guidelines for metric definition 

● Localize several points in the environment. The points should be distributed along 
the whole track.  

● Press Add point button 
● Fill in coordinates of the point 
● Click on the point in the panorama. The video zooms in to allow you fair position 

corrections. 
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Panorama Metric Calibration 
The last step is locating the metric points in the video. The workflow and the look of the 
Calibration screen is very similar to the one in the Panorama Metric Designer.  

 
Calibrating the points 

● Select a point in the model preview (non-calibrated points are rendered in white, 
calibrated points in yellow, actually selected point in red color).  

● Click the point in the panorama (the template preview in the toolbar will guide you). 
The system switches to Detail view automatically to allow you fine positioning of the 
point in the video. 

● Select the precise position of the point. 
● Continue with the next point. 
● Once you have all points placed in the video, press Calculate button (the process 

might take a while).  
When the metric is successfully calibrated, the application starts rendering the wireframe, if 
defined. You can verify the quality of the calibration. 
 
The point selected in the video is rendered as a cross. Projection of the real world point into 
the video is rendered as a circle. In ideal case these two points point to the same spot in 
the video.The last step is locating the metric points in the video.  
The workflow and the look of the Calibration screen is very similar to the one in the 
Panorama Metric Designer.  
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Scene Tracking Static Camera  
Scene tacking can also be used with a fixed camera, this enables the user to account for 
lens distortion during tracking. Calibration process is very similar to the dynamic camera 
workflow. 

 

Calibrating the Static Camera 
● Select static from camera type. 
● Capture single frame from incoming video feed. 
● Select lens distortion in order to apply a line to the captured frame. This line should 

be placed near the edge of the image. 
● The line can then be adjusted using the Slider provided (shown in the image below) 

 

Note 
The position of the line can sometimes vary depending on the image and also the lenses 
that are used on the cameras. 
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ANCHOR TRACKING 
Anchor tracking is a special type of tracking and automatic production.  
During the pre-production setup, select the scene where you want to insert graphics and 
calibrate the scene. Run tracking editor of the desired product, set anchor w17ith name of 
the earlier calibrated scene. Adjust the product.  
During production, when the scene is recognized in the video feed, the graphic object it's 
automatically put into the scene. No human interaction is needed. The object keeps its 
position and size relative to the scene. The object is automatically hidden when scene cut is 
detected. 
 
Anchor tracking is mutually exclusive with sport pitch tracking. Choose the tracker by 
setting the right profile in the config editor. 
 

 

Anchor Tracking requires a license. 

Anchor calibration editor is accessible via Anchor calibration button in the toolbar. The 
same button is used to close the editor. When the editor is active, an additional anchor 
tracking related toolbar appears at the end of the main toolbar.  
 
 
 
 
 
 
 
 
 
Functionality of the buttons in the toolbar 

 Show/Hide the anchor calibration editor. 

 

Show anchor frame for selected products. The button is available only when the 
editor is closed, and the selected products have common anchor set as tracking 
type. 

 

Show live video feed in the preview in case any anchor frame is selected, or 
immediate Capture current frame in case no anchor frame is selected. 

 

Captures current frame. This button is available only when displaying live video 
feed. 

 

Removes all mask areas from currently selected Anchor. This button is available 
when an Anchor is selected and a mask has been defined. 

 
 

 

 
 
Undo last change.  
If previous operation was adding mask, the mask is removed. 
If previous operation was Remove all mask, the removed masks are added back. 

�  
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Resets counters for anchor statistics.  

 

 
 
 
Recapture selected anchor. This button is available when an Anchor is selected.  

1. Capture the anchor frame 
Use toolbar buttons to show live video feed in the preview and capture desired 
frame. 
The application offers to set name for the anchor. The name must be unique. The 
image should not have motion blur (camera should be still) and the camera zoom 
should be as close as possible to shots in which you will insert graphics. 

2. Calibrate the anchor frame 
Select the anchor frame in the Anchor calibration editor. It appears in the preview. 
To provide better tracking efficiency you need to create an tracking mask. When the 
captured video frame contains objects that are dynamically changing (such as 
players, video screen, …) it can degrade the tracking quality. Now draw rectangular 
regions over the regions that can change. These areas won't be used to detect the 
scene in the video feed. 

When scene included in anchor frame changes you should recapture and recalibrate it. For 
example the scene changes from 1st half to 2nd half in soccer game as spectators can 
leave the arena or change  their seats.  
 
Popup menu items for Anchor frames: 

• Rename selected anchor frame. Products linked to this anchor will be updated to 
keep using this anchor.  

• Delete selected anchor frame. 
• Delete all anchor frames. 
• Export selected anchor frame. See Import/Export of anchor frame chapter. 
• Import selected anchor frame. See Import/Export of anchor frame chapter. 
• Import as new. See Import/Export of anchor frame chapter. 
• Replace selected anchor frame. See Recapture anchor frame chapter. 

Mask 
Mask allows manually select area which will not be used for tracking. Anchor tracking is 
based on comparing reference frames with live video input. When reference frame contains 
dynamic parts than there parts can never help the tracker, rather the opposite. During the 
mask setup, the system show points (red crosses) interesting for the tracker. Where these 
points are in area that are not suitable for tracking then add a mask rectangle over it. 
 
Guidelines how to set the mask 

� Make  mask rectangle to just convert the dynamic part. 
� Do not mask spectators when the camera is wide. The spectators are small and do 

not have any negative impact on tracking.  
� Make mask over keyed graphics, such as timing and score titles. (This only happens 

when you are using dirty feed as your input). Beware that the mask has to be added 
in both anchor   frame and in production mask for tracking and insertions. 

� Make mask over players. 
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� Make mask over LED boards on the pitch. 
� It is not required to make pixel perfect mask. 
� Do not mask the whole image.  
� When you mask large portion of the image the tracking won't be reliable at the area. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
Warning indicator 
Warning indicator can appear on anchor frame thumbnail when the image or the mask is 
wrong. Try to capture new image or change the mask. 
 

 
 
 

Correct image masks 
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Incorrect image mask 
Mask does not cover timing and score title that disrupts the matching - mask the timing 
graphics (The timing graphics has to be also masked in Tracking and Insert area for 
production). The mask could mask you points on the pitch that could be used for matching – 
split the mask to several pieces. 
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Import/Export of anchor frame 
There are Import/Export features accessible in the popup menu in the Anchor editor. These 
are useful to reuse previous anchor setting, share the setting among several computers etc. 
Exported and imported are also positions of all products bound to the exported frame.  
� Export – exports selected anchor frame into a standalone file (.afe). The file contains the 

anchor and position of all products tracked using this anchor.  
� Import – imports previously exported anchor from chosen file (multiple files selection is 

supported). Following update rules are applied: 
� Anchor with same name already present is overwritten. Including source 

image and all masks. 
� Products update their position if: 

� They have tracking set to the same anchor 
� They had tracking set the same anchor during export 
� They have same name 

� Import as new – imports previously exported anchor from chosen file.  
� Unlike Import, anchors are not overwritten but added. New name is 

generated for them. 
� Like in Import, there might be products bound to the anchor and exported 

with the anchor. They would update their position (according to update rules 
in Import). Using 'Import as new' doesn't change their position itself, but 
these products are cloned and the position of clones is updated. Cloned 
products are tracked using the newly imported anchor. 

� This operation adds anchors or products and has no effect on existing 
products or anchors. 

� Import from Image -  creates anchor frame from ordinary image file (.jpg, .png etc.). 
Useful for pre-production preparations when only photography of the target scene is 
available.  
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Recapture anchor frame 
There's possibility to replace source frame of an anchor. Products linked to the anchor will be 
automatically updated (position and size). The system computes difference between the 
previous and the recaptured anchor and adjusts their placement. In most cases (when the new 
frame is similar to the previous one), no further position and size adjustments will be necessary.  

1. Select the anchor to recapture. 
2. Press 'Recapture selected anchor' button in the toolbar. Live input appears in the 

preview. 
3. Capture desired frame by the Capture button in the toolbar. 
4. If the difference between the two frames is computed, products are updated 

automatically. 
5. If not, an info dialog appears. You may still choose to replace the frame anyway, in this 

case update position and size of the linked products manually.   
6. Set anchor mask for the new frame.   

 
Create anchor from snapshot 
It is possible to create an anchor from existing snapshot.  
Import Snapshot 
Use popup menu of the Show live video feed button. New anchor will be created from the 
selected snapshot and will be added to the list of anchors.  

 
Replace Anchor by snapshot 
Select Anchor to replace and use popup menu of the Recapture selected anchor button. 
Source image of the Anchor will be replaced by the one taken from the snapshot. The system 
tries to update all products linked to the Anchor (position and size). 

 
Performance notes 

● Anchor tracking requires computer with at least 8 CPU cores in total (2x quad core or 
2x dual core with hyper threading enabled).  

● Every anchor frame adds some processing load to the system. Keep the number of 
anchor reference frames as low as possible. Remove unused frames. 
 



 

                              
 

82   |   Virtual Placement User Guide (v8.1)  

Anchor usage statistics 
In the anchor editor, next to the anchor preview, there's a bar showing recognition statistics. 
The bars show how many times each anchor was recognized, in percentage relative to the best 
one. Bars of rarely used anchors are drawn in red.  

 
The counters can be reset via the Reset counter button in the toolbar. It resets counters for all 
anchors. On every change you make to the anchor (redefine mask), counter for the changed 
anchor is reset.  
 

 
List of linked products 
Hover over the anchor name label in the anchor editor. Tooltip containing list of products linked 
to the hovered anchor is shown. 

Exclusive Visibility Group 
It is possible to attach products to "Exclusive Visibility Group". This feature guarantees that 
only one product in the group is visible at a time. For example you have 2 products, each  
product has different anchor reference frame. Both anchor frames cover the similar place in 
front of camera.  If you attach both products  to the same exclusive visibility group, then the 
system never show both products on air even if both anchor frames are tracked (visible). 
The product that was visible earlier keep visible in the group. When the tracking is lost for 
such product, then other products from the group have a chance to show up. Exclusive 
groups are numbered 1..n.  

Setup the product for anchor tracking 

When you want to use anchor tracking for your product. Follow these steps: 
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1. Choose tracking type to anchor 
Select the product and open tracking editor. Select anchor of desired name in the list of 
tracking types. During listing among the anchors, the anchor reference image is shown 
in the preview.  

2. Adjust the product 
a. Select product you want to insert. The 'Show Anchor Image' button in the 

toolbar gets enabled. Press the button, the anchor associated with selected 
products appears in the preview. 

b. Adjust position, size and other parameters of selected product.   
Once you positioned your product, leave the anchor preview by the same 
toolbar button. This show the live feed again. 

3. Note: The button 'Show Anchor Image' is cannot be pressed (is disabled) when no 
product is selected, or selected product has no anchor tracking selected, or anchor 
frame does not exist (was removed). Please check the tracking types of selected 
product and or anchor frames.  

 
Tracking availability 
Anchor tracking is available when the system recognizes the reference 
frame in the incoming video feed. All products linked to the anchor get 
visible in the preview. Press “GO” to show the products on-air. Products 
with available tracking (visible in the preview or on-air) have small anchor 
in the upper right corner of the Product button.  
 
Every time the system recognizes the reference frame the product is 
automatically placed into the live image. Operators can then show this 
product on air using “Go” button. 

 
Perspective 
You can define perspective for each anchor. Then it can be used to achieve correct perspective 
distortion of the graphics.  
The perspective is based on Vanishing point(s) definition for the real scene. Then the system 
can make sure, the vanishing points of the graphics and the scene are equal.  
The perspective is saved together with the anchor. 
 
Define Vanishing points 
Activate the anchor preview. Two Vanishing point buttons appear next to the Anchor preview 
button. 
If the vanishing point has been defined, the icon changes to indicate that it is ready to use. 
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Operation pattern: 
Select one Vanishing Point button.  

Draw pair of lines into the video preview. These two lines must be parallel in the real scene.  
 

Select the second Vanishing point button and draw another pair of lines in the preview. Again, 
this second pair of lines must be parallel in the real scene. Moreover, the second pair of lines 
should be perpendicular to the first pair of lines.  
 
Generally, the second vanishing points is not needed to be defined. With one point perspective 
the system shows perspective hint in one axis of the graphics only.  
 
During Vanishing point definition the graphic is hidden. Unselect the Vanishing point button to 
go back to graphics adjustment mode.  
 
There is popup menu available for each button: 
Disable – Disables the vanishing 
point. Definition of the point is kept.  
Since then, the point is handled as 
undefined. The point is re-enabled 
by pressing the button again. 
Reset – Clears the lines defining 
the point. You can redefine the 

lines.  
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Perspective use 
The perspective setting is available in anchor preview only. Vanishing point buttons must be 
unpressed and at least one Vanishing point must be defined.  
 
Adjusting graphics by corner manipulators 
When you drag or hover one of the corners of a product, the system provides hint where the 
corner should be placed to fit the perspective (see the magenta-color lines).Automatic snap: 
drag the corner manipulator close to the computed position. It will jump to computed position 
automatically. 
 
 
Automatic setting 
Hover the translation manipulator in the center of the product. The system provides hint around 
the whole product that fits the perspective. Now you can press shortcut for the 'Set 
Perspective' action. The graphics will fit the hint rectangle. The action is also available in main 
menu Edit → Set Perspective and include current keyboard mapping. The menu action works 
when only one product is selected.  
Also the shortcut can be used without hovering the product when only one product is selected.  
 
 
One vanishing point perspective 
When only one vanishing point is defined, the system provides hint in one axis of the graphics 
only.  
Hover or drag one of the corner manipulators. Lines from the vanishing point is drawn. The line 
connects positions, where the corner can be placed to fit the perspective. Snap to the line 
during corner dragging is also provided.For one point perspective the automatic setting is not 
available. 
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PROGRAM — ISO COMPARISON 
The 8.1 release introduces a new program-to-isolated camera comparison workflow that 
supports Virtual Placement as a downstream solution. The workflow reduces delay and 
helps ensure the correct calibration is loaded when a camera goes to air on the VP output 
 
In this specific setup the isolated camera is coming in to VP on the first input 
<AuxCameraIds value="0"/> and the PGM feed is coming in on the second input 
<CameraId value="1"/>.  
 
The delay between PGM feed and the isolated camera can be set but in most cases the 
PGM already adds a natural delay in comparison to the isolated camera so <Delay 
value="60"/>  

● Can be set to 0 as a starting point when setting up. 
● Delay is set in frames/fields 

To add the function into VP this following code needs to be added to the advanced section 
of the config editor: 
<MixedFeedTracker> 

    <CameraId value="1"/> 

    <AuxCameraIds value="0"/> 

    <!-- approx. 1 second delay for 59.94 Hz --> 

    <Delay value="60"/> 

</MixedFeedTracker> 
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TRACAB PLAYER TRACKING 
This product integrates Tracab player tracking technology with Virtual Placement. Tracab 
system provides information about players positions. This can be used to visualize player 
attached graphics. 
Before using this product you are required to do manual configuration. See Installation 
guide for more details. Once configuration is done you should be able to add this product 
to your project.  

 

 
Tracab Settings editor 
You can set two team colors. These colors helps you recognize the teams. The colors are 
only used in the preview or in the UI. The color is never used in final video rendering. The 
setting is stored in application wide storage, not in project file. 
Players Definition File editor allows you to choose a file containing player lineup. 
 
Player Selector and Player Icons 
Enable or disable Tracab Player Selector and Player Icons. Player lineups are shown next to 
the preview window and player icons show up in the preview.  
 

 
Player Icons 
Under each tracked player, small rectangle with player number is rendered. There is a thin 
color bar at the top of the player icon that indicates player team. If the target has no team 
assigned then no color is rendered. If no jersey number is assigned then no number is 
shown.  
The player icons and can be selected/unselected by clicking a mouse.  
The icons are clickable even when jersey number or team is not assigned to the player. 
Then you can show graphics for these players without need to assign jersey number in 
Tracab system. Selection is visible in preview only and there's 'X' mark rendered for 
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unassigned players on the Product button.  
 
Tracab Player Selector 
The selector contains 2 panels on both sides of the video preview, with buttons for all 
players defined in Players Definition File.The buttons serve for fast selection of players and 
load the selected into a Tracab Players product. The selector contains all players from 
Players Definition File in given order.  
Selection in the tracab selector is cleared each time the Selector is open. Additionally you 
can clear the selection from popup menu invoked anywhere above the Selector. 
 
Selection Workflow 

1. Select players you would like to load into the product (in the Tracab Player Selector 
or click the Player Icons. 

2. Press Tracab Players product button – selected players are loaded and visualized 
on the product button.  

 
When the Player selector is visible, all clicks to the product will update players assigned to 
the product. To select the product, click the Product button with CTRL key down, click the 
bottom button of the Product button or close the Player Selector. 
 

 
Players Definition File 
Information about available players are delivered via xml file. Specify the file in the Tracab 
Settings editor. The file has following structure: 
<Tracab> 
 <HomeTeam> 
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   <Group name="Lineup"> 
     <Player jerseyNo="2" lastName="Vales" myVariable="25"/> 
     <Player jerseyNo="1" lastName="Alves" myVariable="26"/> 
     … 
   </Group> 
   <Group name="Subst"> 
     <Player jerseyNo="2" lastName="Ferreira" age="31"/> 
   </Group> 
 </HomeTeam> 
 <AwayTeam> 
   <Group name=""> 
     <Player jerseyNo="2" lastName="Ferreira" age="31"/> 
     <Player jerseyNo="3" lastName="Ramos" age="28"/> 
    … 
   </Group> 
 </AwayTeam> 
</Tracab> 
 
Mandatory elements and attributes are bold. Except those, you can add any attributes to the 
Player element of your choice. All attributes can be referenced in the Style editor and rendered 
in the Player graphics. 
The players can be divided into several groups. Each group of players is displayed in its own 
tab in the Player selector. When each team contains only one group, the tabs stay hidden.  
A third party application can send updated data via an XML, which Virtual Placement can read 
automatically if the auto update is enabled within the Tracab editor. 
 
Product Button 

Player tracking product can render graphics attached to individual player. The graphics is 
customized by style. The style is user editable. 
The thumbnail of the button is composed dynamically, according to elements actually enabled 
in the style.  
 
The thumbnail contains player numbers assigned to this product. Each player number has 
background assigned to its team (see Tracab Settings editor.)  
 
Team Editor 
Team editor is accessible from the popup menu of the Product Button. You can reserve the 
Tracab players to single team only. When a team is specified, the product will contain only 
players from selected team. This filtering rule is applied during selection only (see Selection 
Workflow).  
 
Style editor 
The player is visualized according to the defined style. The style is embedded inside the 
product and therefore stored in the project file. If you want to share the style you can export 
and import the style to/from a separate file. 
Style editor is accessible from the popup menu of the Product Button. 
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The graphics is composed of several parts.  Each part can be disabled/enabled. You can use 
either image file or GTC clip file. The system can automatically recognize the file type. For clip 
you can define a loop start frame. This is useful when your clip has a in-animation to show the 
graphics and then a looping part to be used during the presence on the screen. There is a 
short fade-out when taking the graphics off air. 
 
 This icon on the tab means that part of the graphics defined in the tab is enabled and will be 
rendered. 
Additional lines can be added to the above player text providing greater flexibility when creating 
top fonts. 
 
 
Variables 
Text and File fields may contain a variable, which is later replaced by its value.  
 

$(TRACAB:myVariable) Replaced by value of myVariable attribute defined for each 
player in the Players Definition File  

$(TRACAB:TEAMID) Replaced by team identifier. TEAMID is NOT a reference to 
attribute name, but is replaced by following constant: 
1 – for Home team 
2 – for Away team 

 
Variable can reference value of any attribute of the Player element defined in Players Definition 
File. When the variable is used in File field, you must specify, whether the referenced file is an 
image or a GTC clip.  
 
Text Formatting 
Some graphics can contain a text field. There are values provided by the application that can 
use used in formatted string. See table of all supported variable names on page . 
 
The format string is is compatible with ANSI C printf() function. Example: 
 %.0f -  no decimal digits (e.g. 10).  
 %.1f -  one decimal place after the decimal point (e.g. 10.1).  
 %MPH$.1f – picks value “Speed in miles/hour” and uses one decimal point formatting. 
 
Supported value names 

KMH Speed in km/h 
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M Distance in meters 
KM Distance in kilometers 
MI Distance in miles 
YD Distance in yards 
FT Distance in feet 
MPH Speed in miles/h 
MS Speed in m/s 
Pid Custom property of given ID. The ID is a number. 

 
Element - Graphics under the player 

The graphics is centered on the player position.  
The tracking type is "Pitch".  
Keyer is set to chroma keyer.  When multiple chroma keyers are in use, you can select the 
keyer instance in popup menu "Keyer" for the Tracab product. 
 
Colors 
Original colors: No effect will be applied.  
One color: White color in the graphics is replaced by user defined color. 
Three colors: RGB colors are replaced by three user defined colors. 
 
Opacity applied to the image/gtc clip. 
 
Size 
Fixed: Graphic element keeps constant size defined in the style editor [in meters]. 
Scale: Scale the graphics to another player. You can choose among Closest opponent, Closest 
teammate and Next selected player.  
Player 2 coords: you can define point in the texture of the 2nd player [in range <0, 1> for both x 
and y where [0, 0] is lower left corner of the texture]. Center of the texture is under the 1st 
player.  
 
 
Element - Graphics above the player 

 X
+

Y
+

Z
+

 

X+ 

Y+ Z− 
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The plane with the player graphics automatically rotates in Y axis to face the camera. The 
graphics is centered in X and touches the pitch at the player position. 
 
Keyer type is linear. 
The visibility order is fixed so the image/clip is always behind the jersey number. The order 
cannot be changed. The Z coordinate does not have any effect on the ordering. 
 
Colors 
Original colors: No effect will be applied.  
One color: White color in the graphics is replaced by user defined color. 
Three colors: RGB colors are replaced by three user defined colors. 
 
Opacity applied to the image/gtc clip. 
 
Minimum Size - You can specify minimum size of the graphics. It is guaranteed, the graphics 
is never scaled down under the specified value. Minimum size is set in percents of the screen 
size (0 means disabled, value of 100 means full screen size.) 
 
Text delay in 
When a non-zero value is set, the text production begin is delayed (by specified number of 
video fields.) After that time, the text begins to fade-in. 
 
Text delay out 
When a non-zero value is set, the text production is finished at after given number of video 
fields from the stop production command (incl. fade out.)  
 
Loop/Pause - Can be applied on .gtc clip.  
Loop – specify frame, where the loop begins. When in on-air, the clip will loop from the loop 
begin to the end of the clip.  
Pause – specify frame, where the clip is pause when on-air. Press the GO button again to play 
the clip to the end. Allows to have animated out-effect.  
 
Text can have named values. See Text Formatting. 
Distance Measuring 
Absolute - Length of player's trace form the start of the match. 
Elapsed - Length of player's trace form the moment the product gets on-air. 
 
Text Style – see Text Style. 
 
Element - Interconnecting lines 
Connects selected player by lines. Lines are rendered in the pitch plane. Lines can be optionally 
textured.Players are connected in the order as they were selected.  
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Optionally you can enable rendering of distance between the players. The distance is rendered 
next to the center of the line (if the center of the line is on the left side of the pitch, the text is 
rendered on the left hand side as well, and vice versa). You can specify offset from the centre 

of the text. The offset is set in meters from the center of the interconnecting line in the 
coordinates of the line. The orientation of the coordinate system depends on the side of the 
pitch. The text can be placed on the pitch, in upright billboard mode, or billboard facing mode, 
which always faces the camera. 
Text can have following named values (presented in order). See Text Formatting. 

M Meters 
KM Kilometers 
MI Miles 
YD Yards 
FT Feet 

 
Text Style – see Text Style. 
 
Fill - Creates fill polygon with specified color between selected players. When the fill is 
combined with Interconnecting lines, an extra line is added between the first and the last player, 
so the lines form outline of the polygon fill. 
 
Convex Hull – Ensures the Interconnecting lines from a convex polygon (not crossing each 
other). Applies only when the Interconnecting lines are closed (Fill is enabled.) 
 
Fixed Point - Allows the user to select a fixed point within the image, and the assign additional 
points to moving targets.  
 
Element - Trail 
Draws trajectory of a player. The trajectory is rendered in the pitch plane.  
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Like the Interconnecting line, the trail can be optionally textured.  
 
Trail type 

FROM_START The trail is drawn from production start to current player's position.  
TO_END The trail is drawn from current player's position to the end (shows 

where the player will run). This mode is available when production start 
and end is known (see Video file Recorder, Game Actions). 

 
Element -  Lower third 
Displays label with actual performance information for actually selected player(s).  

● All graphics used in Distance and speed are positioned in screen coordinates. 
● Tracking and chroma keyer is disabled.  
● Position of the background image/gtc clip means position of its center. Position of the 

text is defined by offset from the background position to the pivot of the text. The pivot 
is dependent on the text alignment and is computed from its bounding box (middle of 
the left side for left aligned text). 

● Text can have named values. See Text Formatting. 
Distance Measuring 

• Absolute - Length of player's trace form the start of the match. 
• Elapsed - Length of player's trace form the moment the product gets on-air. 
• Difference – Distance between two players.    

Screen coordinate system 
The center of the system is in the middle of the screen, with coordinate [-1,-1] in the lower left 
corner, and [1,1] in the upper right corner.  
 
Text delay in 
When a non-zero value is set, the text production begin is delayed (by specified number of 
video fields.) After that time, the text begins to fade-in. 
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Text delay out 
When a non-zero value is set, the text production is finished at after given number of video 
fields from the stop production command (incl. fade out.)  
 
Text Style – see Text Style. 
 
Element -  Offside 
Displays 2 lines, one on position of the last 
defender, one on position of the attacker closest 
to the opponent's goal line. When the attacker is 
in potentially positive offside position, the attacker 
line might be drawn using different color.  
Offside ignores players actually assigned to the 
product, the players concerned are picked 
automatically. 
 
Style 

• Texture – Offside line texture. The texture is stretched vertically to cover the whole 
pitch width and horizontally to fit specified width.  

• Width – Width of the lines on the pitch (in meters). 
• Defender – color of the line drawn on position of the last defender. 
• Attacker default – color of the line drawn on the position of the attacker closest to 

opponent's goal line, not being in offside position. 
• Attacker offside -  color of the line drawn on position of the attacker in potential 

offside. 
• Team – Attacking team. The attacking line is drawn for attacker from this team, the 

defender line is drawn for player from the opponent's team. Use two Tracab Players 
products with different Team set to cover offside for both teams. 

• Heatmap — Virtual placemen has the ability to show a heatmap under players when 
integrated with a Tracab system. The heatmap functionality will only work with live data 
from Tracab (using TDC 4.5.9.2 or later), this capability is not supported in replay mode. 

 

 
 
Texture – Select graphic file for heatmap texture 
Opacity – Adjust the transparency of the texture 
Fade – In/Out dissolves for texture  
Render mode – Smooth will soften the squares for a more fluid look to the heatmap (as 
default). 
 – Tiles will maintain the squares edges for a more chequered look to the heatmap.   
 



 

                              
 

96   |   Virtual Placement User Guide (v8.1)  

Automatic playback pause 

 
Set pause point at the time of an Offside situation (use Pause button next to the product 
button). During playback, the video will stop at this point.  
The stop point is shared for all Tracab Players products. However, the stop point can be stored 
to a clip (see Video file Recorder, 'Store product selection to the clip' toolbar button). Once the 
clip is recalled, the product is automatically selected and saved pause point is activated.  
Text Style 
Text style is placed in a standalone .xml file (having TextStyle root element). The style is 
referenced from the Distance and Speed Style editor. Style may contain following properties of 
the text.  
 

FontHAlign Horizontal alignment  
{ LEFT | CENTER | RIGHT | DOT_FIRST | DOT_LAST } 

FontHAlignChar Horizontal alignment character 
FontVAlign Vertical alignment { TOP | CENTER | BOTTOM | FIRST | LAST }     
FontLineSpacing Relative line spacing. Value 1.0 means spacing by the height of the 

font. 
FontLineFlowPolicy Behavior for lines wider then defined limit.  

{ DONT_CARE | SCALE |  UNIFORM_SCALE | SOFT_NEWLINE | 
HARD_NEWLINE |  SOFT_SKIP | HARD_SKIP  
| SINGLE_LINE } 

FontLineWidth Line width limit. (see FontLineFlowPolicy) 
FontFixedPitch Fixed character pitch. (disables kerning defined by font). 
FontKerning Additional kerning. 
FontCapitalsRatio If enabled (value > 0) then all characters are made capitals. The 

original non capital letters are rendered smaller. This value defines 
factor for that scale. 

FontName Name of the font. All system fonts are available. 
FontResolution Font texture resolution in pixels. It should approximate match the 

pixel size on the screen. 
FontBaseColorMode Coloring text mode. { SOLID | CHAR_4POINTS | LINE_4POINTS | 

GLOBAL_4POINTS | LINE_2GRADIENTS } 
FontBaseColor Color to be used when mode is SOLID 
FontBaseColorP1 Color for gradient coloring 
FontBaseColorP2 Color for gradient coloring 
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FontBaseColorP3 Color for gradient coloring 
FontBaseColorP4 Color for gradient coloring 
FontOutlineSize Size of outline in pixels. Set to zero to disable outline. 
FontOutlineColor Outline color. 
FontShadowOffset Relative offset of shadow to normal text.  
FontShadowBlur Amount of blur of the shadow. 
FontShadowColor Shadow color. 
 
 
Example: 
  <TextStyle> 
    <FontHAlign value="RIGHT"/> 
    <FontCapitalsRatio value="0.7"/> 
    <FontName value="Arial-Bold"/> 
    <FontResolution value="70"/> 
    <FontBaseColor value="[0.29,0.32,0.69,0.84]"/> 
  </TextStyle> 
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FEATURES 
Virtual Video Screen (Jumbotron) 

 
The video screen object allows you to enhance the production with big virtual video wall. 
The video screen is made of two components: 

• Clip: The look of the video screen is made by the clip file. The clip defines the 
opening/closing animation and the overall design of the video screen. The clip also 
defines how the video signal is inserted into the clip images 

• Live Video Input: The video is delivered to computer as SDI signal and mixed with 
background clip. 

 
Video Screen Configuration 
You have to configure video texture. This configuration must be done manually. 
 
Open config.xml (Use shortcut accessible via Start → Programs → Virtual 
Placement → Config Editor) 
 
Navigate to section VideoTexture and change the setting based on following tips: 
    <VideoTexture> 
      <Enabled value="1"/> 
      <WithAlpha value="0"/> 
      <CardId value="0"/> 
      <ConnectorId value="1"/> 
    </VideoTexture> 
 
The card Id/ connectorId depends on your HW configuration. If you have one Bluefish SD 
DualLink Pro card, then the CardId is 0 and ConnectorId is 1. (ConnectorId 0 is used for main 
video input). 
 
Once you modify the file, restart User Field Product = Virtual Placement. You can verify the 
video texture functionality by adding product „Video Input“. You should see the picture that 
comes on SDI input. 
 
Video Screen Preparation 
The clip can be designed and rendered using 3DS Max 7 or newer. The rendered image 
sequence must be converted to GTC file use GTC Clip Convertor 2.0 or newer. See page 
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Appendix A – GTC Video Warping Support for more details. 
 
Video Screen Production 
To show the video screen you need the clip file (GTC), properly configured User Field Product = 
Virtual Placement and valid SDI signal. 
When you load a valid clip file the system automatically recognize that the clip contains 
information about insertion of video feed. The clip is then mixed with video in both preview and 
main output. Once the clip is loaded, the production is then exactly the same as normal clip file.  
 
Video Screen Settings 
There are some options that can be adjusted inside the warping clip's Video editor. 
 

Video Feed Background Background video is used as the effect video. 
 Input 1 Video texture input (see config.xml) is used as a video source. 
Warp Mode DEFAULT Video feed color is combined with a gtc clip color. Allows to create 

e.g. shadow on the video area. 
 BLEND Useful when there are some semi-transparent areas of video. 

Handles premultiplied aux alpha better than BLEND. 
Warp UV 
Source 

TEXTURE Aux UV channel of gtc clip is used as a warp effect UV source. 

 CONTENT Bounding rectangle of the clip defines mapping UV coordinates. 
No need to have aux UV channel in gtc clip. Useful for video 
masking. 

Chroma Keyer 
To adjust keyed colors for the chroma keyer, display the Chroma Keyer Editor using the 
Chroma Keyer button (1) in the main toolbar.  

The editor contains button for removing the whole chroma key setting for current chroma key 
instance (2), button to Undo the last pick (3), 3 preview modes (4) and 4 chroma key instances 
(5).  
First, select the instance you want to edit. The instances are independent on each other, each 
product can use different chroma key instance. The chroma key instance can have user 
defined name. Rename action is accessible from the popup menu for each instance.  
 
All the time the editor is active, you can pick the chroma color in the video preview. The picked 
area used to recompute the keyer color is drawn as square. You can adjust its size by mouse 
wheel. Currently picked color is added to the set of existing colors. The color setting is camera-
wise and must be set for all live cameras individually. Recorder uses color settings from it's live 
camera.  
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There is a Copy&Paste feature accessible from the main menu or keyboard shortcut. Copy and 
Paste operations are invoked in context of currently selected chroma key instance. They don't 
affect other instances. Settings for all cameras are copied/pasted. 
 
Export/Import 
You can export the keyer setting into an external file of your choice (.chr). This allows you to 
create collection of settings in pre-production time, and switch the setting during production. 
Or share the settings among several computers. 
Export and import is done on the selected chroma key instance, the others are not affected. 
Exported is only setting for the currently selected camera, and import replaces setting selected 
camera only as well. 
Try to pick colors that are similar by one pick. If the colors inside the picking area differ too 
much then make two picks. 
 

 
 
The best way to set the chroma key correctly is using one of the keyer preview modes.  
Mask: Shows the keyer mask. The white areas will be used for keying and will be replaced 
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by a product. The black areas will keep the original color and won't be used for keying.  
Preview: Shows combination of mask and original video, which makes the picking easier. 
Partially transparent color shows the areas which will be keyed.  

 
Keyer Setting 

1) Select one chroma key instance 
2) Select one of the preview modes. 
3) Resize the picking area by the mouse wheel so it covers as large an area as 

possible for picking. 
4) Pick one of the 'dirty' regions which you would like to be keyed, but is not covered 

by the keyer color yet. 
5) Repeat steps 2-3 until the chroma keyer colors contains all desired colors for keying 
6) Repeat steps 4-4 for all live cameras. 
7) Repeat steps 1-5 for desired number of chroma key instances.  

Choose chroma key to use 
Each product can use a different chroma key, the list of chroma keys available is in the 
Keyer & Fade editor accessible from each product's popup menu.  

 

Automatic (Adaptive) Chroma Keyer 
If Adaptive keyer has been enabled, the Chroma key editor will only show the key that has 
been generated automatically. It is not possible for you to add or remove Chroma keyer 
colors when adaptive keyer is enabled but adaptive keyer can be disabled in runtime. 
 

Recorder 
Virtual Placement comes with a built-in disk recorder. You can switch from live feed to 
recorded footage using the Camera button in the Toolbar. The Recorder mode allows the use 
of all the production tools available in Live. You can go through recorded footage using the 
Jog/Shuttle device.  
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Jump to time (time of the day of the target record)  function is available in the main Menu → 
Tools.  

 
 
RAM Recorder 
The built-in video recorder set to RAM mode doesn't have large capacity. Ram recorder is 
useful for quick replays (typically an offside situation). 
RAM clips export 
It might be useful to store the current clip for later playback, e. g. for highlights after the match. 
If you're in an offside clip, which you would like to save for future use, press the export clip 
button. A dialog with export progress appears. The operation may take a while, about 10 
seconds for HD clips. The clip is exported including data to replay the offside. The export 
process is executed in the background. You can use the system normally during the export. 
Length of the exported clip is the same as recorded footage available for offside production, in 
default about 30 seconds.  
The clips are exported in internal format and can be played in Virtual Placement only.  
 
Stored RAM Clips Playback 
Exported clips dialog can be invoked from the exported clips button or from JLCooper 
Jog/Shuttle controller by pressing button W4 (default function). The dialog allows simple clip 
administration (remove, rename).  
Before import, make sure the calibration corresponding to the source footage is loaded.  As the 
clip is loaded, you can do usual operations available during offside production. 
Important note: The clip is exported including all tracking data which are used for playback. If 
the tracking is incorrect, you can override the saved data with semitracking. Mind, you can use 
either saved or semitracking data only! Semitracking in clip doesn't restart tracker to produce 
exact automatic data as you're used to it from live cameras! 
 
The exported offside clips dialog could be controlled also using JLCooper Jog/Shuttle as 
shown on the following schema:
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Video file Recorder 

Recorder set to Video file allows to use larger video file than RAM mode.  
 
When part of recorded footage is marked as Clip, it is locked and never overwritten. Not locked 
footage is periodically overwritten.  
Each clip is defined by its In and Out point. These points can be redefined later. 
Existing clips are accessible from the menu for Camera button. For better orientation the menu 
contains date and time when the clip was created.  
Once the clip is selected, its name is rendered on the Camera button.  
The clip might be locked in all available recorded cameras (depends on the configuration, see 
Installation Guide, chapter 'Recorded Clips'. You can switch between cameras using the 
camera popup menu or keyboard / Jog Shuttle mappable actions.  
 
Create clip 
Mark In and Out point of the clip and press Create clip button. The clip is created and recalled.  
Clip can be created with only In or Out point. Mark one of the points and press Create clip 
button. The system automatically computes the complementary point according to the default 
duration specified in config and creates a clip. In this case the clip is not automatically recalled. 
When a clip is selected you can Delete and Rename the clip from the Camera button menu. 
You can map actions to set In/Out point to the Jog/Shuttle controller. 
There's also FastJogSwitch action mappable to the Jog/Shuttle controller, which accelerates 
jog and shuttle for faster navigation in the recorded footage.  
 
Toolbar buttons 
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The point is not defined. Press the button to define In/Out point.  

 
The point is already defined. You can still press the button to redefine the 
In/Out point. Current timecode differs from In/Out point of the clip. 
 
 

The point is already defined. Current timecode equals to the In/Out point of the clip.  
 
Create clip with previously defined In/Out points. 
 
 

Store product selection to the clip. 
 
 
Play recorded footage.  
 
 
Stop playback. When pressed in Live, recorder camera is selected. 
 

 
Clip Playback 
Select the clip in the Camera button menu and press play. Start point of the clip is 
cued. Playback stops on the End point of the clip. You can go over the In/Out using 
the Jog Wheel.  
Start and End points of the clips is computed from its In/Out point after Preroll and 
Postroll are applied. 
You can map actions to select a clip to the Jog/Shuttle controller. 
 

 
Preroll and PostRoll 
When the Preroll or Postroll is defined, the playback of the clips starts or ends 
beyond In/Out point of the clip. You can change the value in the Config editor, 
in the Advanced tab: 

<RecordedClips> 
        <Preroll value="250"/> <!-- seconds * fps --> 
        <Postroll value="250"/> 
</RecordedClips> 
     
Production selection stored in Clip 
State of selected products is stored into a clip when the clip is created. On clip recall, all 
products are deselected, the products stored to clip are selected.  
Products are referenced by their names in the clip. Having multiple products with same name 
may lead to unexpected results.   
Clip export 
Clips can be exported from the Video file into standalone file which can be played by any video 
player.  
Export is available in the Camera button menu when a clip is selected. 
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Export dialog 
Displays and allows to edit properties of the exported clip. 
 
Clip ID 
File name for the exported clip. Destination folder is added automatically if not specified. File 
extension is added automatically according to selected export profile. You can see full path to 

the exported clip right bellow the Clip ID edit box.  
 
Destination 
You can have several predefined export settings (configurable in the Config Editor) and switch 
quickly among them. Destination contains path to export folder and predefined Profile.  
 
Profile 
You can have several profiles defined (with different parameters for the output codec). These 
profiles can be added and edited in the Config editor.  
Export fails when there are invalid parameters set for the profile. Usually with error “Operation 
not permitted”. 
Some of the codecs (like DnxHD, ProRes) are not available until a valid license is present. 
These licenses are distributed within Virtual Placement license.  
 
Exporting 
The process itself is blocking - a dialog with progress of the export is shown and prevents any 
action that would corrupt the exported clip. Once the export is finished, the clip is ready for 
playback in any media player.  
 
Tracking data 
Exported clip can contain information about tracking, players movement etc. These data are 
stored as metadata in the exported clip file. The data are present when: 
this information is available (the tracking is not disabled) 
selected file format supports storing metadata (currently only .mov is supported) 
Tracking data might be used later when the clip is imported into Paint. 
 

Game Actions 
The idea of Actions is to mark start and end of interesting segments during the match. 

Later you can navigate through the Actions and create Clips from the Actions.  
Unlike Clips, the action is defined just by marks in the recorded footage. Until no Clip is 
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created from the Action, the footage remain unlocked (might be overwritten) and all Actions 
are lost when the application is closed.  
Production in a Actions works the same way as for Clips.  

Toolbar Buttons 
Show Action toolbar via 'View → Action Toolbar' menu item.  

 In/Out point has not been defined.  

 The In/out point has been defined.  
 
Create clip from currently selected Action. The clip is 
selected and ready to play.  

  
Use IN/OUT point buttons to define start and end of the Action.  

 
Sequence 

 
Meaning 

IN, OUT Mark in and out of the Action. 
IN, IN Redefine in to current timecode. 
OUT, OUT Redefine out to current timecode. 
IN ,OUT, IN Mark in and out of the Action, mark in for the next Action.  

  

Navigation 
There are actions mappable to the Keyboard shortcuts or MCSP Jog/Shuttle buttons. 
 

Available Actions 
ActionBegin Mark IN. 
ActionEnd Mark OUT. 
ActionJumpToFirst Go to first Action. 
ActionNext Go to next Action. 
ActionPrevious Go to previous Action. 
ActionToClip Create Clip from current Action. 
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Camera Snapshots 
You can create snapshots from the live camera feed. It is helpful to create or tune graphics, 
without live input at time of preparing. In the office you can load snapshot of real stadium, 
and arrange graphics for the next production. You will get immediate feeling “how it looks 
like”, without any additional source of video stream. 

You can see the snapshot with the graphics at the video output line. See installation Guide, 
Snapshots chapter. 
Snapshots are controlled by the Camera button in the main Toolbar.  
Snapshot menu item shows previously taken snapshots. It contains only those, which have 
been taken using the same Video Format, that is used for current session. 
To load one of them, just select the corresponding menu item. Leave it by selecting one of  
Live cameras in the menu.  

Snapshot Import/Export 
Snapshot images can be exported or imported to/from image file. Supported are common 
image formats (.jpg, .png etc.). 
The export and import of snapshot image causes lots of certain information that are 
normally stored in snapshots. Data like chroma keyer setting and tracking data are not 
exported. 

  

Score Widget 
The Score Widget is here for you to ease up production 
containing actual score. You  can change score very simply by clicking the 
increase/decrease button.  
Score Widget sets application variables SCORE1 and SCORE2 to the value shown on the 
widget.  
See Appendix C – Application Variables.section and Text Product section to learn how you 
can use those variables in the production.  
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Mask 
The mask setting has allows to define portions of video screen that will be excluded from 
tracking and inserting any of your graphics. 

 
 
 
 
 

This mask  is useful when you want to not overlay your graphics over timing and score 
graphics already present in the video. The same area is also very good to exclude from 
tracking. Black borders around the video should always included in the mask. Especially 
when doing graphics of already letterboxed video. 
 
 

 
The Mask is visualized permanently as a red transparent color over the video. 
  
Insert area setting is stored in the project, so it will change when other project is loaded.  
You can prepare several masks in your project. The masks could be then switched by 
keyboard shortcuts Ctrl-1 up to Ctrl-9. Switching the masks can be done even if the mask 
editor is not open. 
 
You can define the Mask in two ways: 

� Rectangular area drawn manually 
� Loading mask stored in an image file 

 

Mask editor 
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Click the Show Mask editor button in the toolbar.  

The editor contains thumbnails of all masks available for current project.  
 
When the editor is open, an additional toolbar appears next to the main toolbar.  

 
Show/Hide the Mask editor 

 Add Image mask. File chooser appears to browse for the mask file. 

 

Removes all negative regions from currently selected Area Mask. This button is 
available when the Area mask is selected. 

 

Undo last change. 
� If previous operation was adding mask, the mask is removed. 
� If previous operation was Remove all mask, the removed masks are added 

back. 
  
Area mask 
Select the Area mask item in the editor.  (first on the image above) 
There is a rectangle with 4 manipulators (1) in the preview window. Set them to define a 
bounding rectangle where the products can be shown. Graphics outside this area won't be 
visible.  
The global rectangle defines positive region, where the rendering will be performed, but 
sometimes you may want to define negative sub-regions, to keep them clean of product 
rendering (2). 
In this case, just press left mouse button in the preview and draw the desired negative 
rectangle during Insert area editing.  
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Insert area not set Insert area set to follow the black region 
 
 

Negative region set on the score bar No negative region set 

Image Mask 
When the mask is more complicated you can prepare your own image masks in advance. 
First prepare the mask. Create a gray-scale image with the same resolution as set in your 
system. The black pixels makes normal graphics insertion and those that are tracked. The 
white pixels makes the graphics invisible and are ignored by the tracker. You can use 
Black/White gradient to control the opacity of graphics insertion. Save the mask into a PNG 
file and copy into your project directory. The mask image can look like this: 
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You can remove the image mask from popup menu of an Image mask item.  

AutoMask 
Automatic masking provides a more automated process for masking out and replacing 
elements within the video feed. 

Typically It can be used on lower third or game clock area within the incoming video feed. 

In this mode a mask is selected from a predefined sets of masks, the mast selection is then 
done automatically according to the Mask templates that were available. 

The mask must have the same name as It’s counterpart template image In order for Virtual 
Placement to replace the image. 

To add a mask with its template open mask editor click an  mask button and pick a mask 
image, template images will be searched and associated automatically 

Supported file formats are TGA,PNG,RGB and JPG. 

Example: 

Image mask path: 
C:/User/User/Documents\VirtualPlacementProjects/mask/ImageMask.png 

Template path: 

C:/User/User/Documents\VirtualPlacementProjects/mask/templates/ImageMask.png 

In order to enable auto masking,Select the virtual placement config editor and the click the 
Render tab. 
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It is possible to override automatic mask selection by invoking 
SelectMaskOverride/DeselectMaskOverride actions. See Actions.html documentation for 
detailed info about these actions. 

Video Status Dialog 

Open the Video Status Dialog via Tools → Video Status menu item.  

 
 
The upper part of the dialog contains table with: 

� All available (connected) signals . 
� Their actual video format. 
� Their audio status (Volume Unit meter). If audio channel count is 4 or less, 

horizontal audio bars are used, in the case of channel count is greater than 4 and 
up to 16, audio is rendered to smaller vertical bars.  

� The amount of Drop frames.  
 

Reference delay 
The plot displays delay between input signals and genlock. Well synchronized inputs with 
genlock result in delay values close to 0. Constant value other than 0 can be compensated 
by Genlock setting in the Config editor. Increasing, decreasing or wobbling chart indicates 
that the input is not synchronized with genlock. 
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Time Status 
Status bar shows both Video timecode and System time.  
 
 
Video Timecode 
Shows video timecode of the video frame currently displayed in the preview formatted 
human-readable form. This timecode is an internal timecode without real meaning, but might 
be helpful for navigation in the recorded footage.  
 

  

JLCooper Jog/Shuttle MCS3 Control 
  

Function Assignment Customization 
You can change functionality connected with the buttons. To 
do that, modify function assignment in the config file. See 
Installation Guide with more accurate description and list of 
available functions. 

Controller Setting 
Mind that JLCooper Jog/Shuttle needs specific installation. 
See Installation Guide for more information.  

  
 

Error reports 
In case of problems with functionality of Virtual Placement please don't hesitate to contact 
us at: support@chyron.com. 
Please don't forget to attach log file, which is located at  
C:\log\Chyron\VirtualPlacement.txt. 
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APPENDIX A  
GTC Video Warping Support 
 
Since version 2.0, GTC Clip Convertor application allows to embed video warping channel 
into the clip. Warping allows to combine clip graphics and video data coming from 
secondary video input during production. Effects like virtual screen can be realized with 
that. 

 
 
 
Video Warping overview 

Clip RGBA 
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Warping Clip Creation 

To create GTC clip containing warping channel, the artist creating the clip in a 3D rendering 
application must render two sets of images: 

� primary clip RGBA   .tga, .png, ... 
� video warping   .rla 

 
Video warping images must contain following channels: 

� alpha channel   defines where the video input is visible inside the clip area 
� UV channel   defines how the video input rectangle is mapped into the clip 

area 
 

Tips for using 3ds max To Create Warping Clip 
1. Rendering RGBA frames 

 
� Preferred RGBA format is TGA that allows to disable premultiplied alpha. 

 
� To get correct shading of the video surface, material of the video surface should 

have following parameters: 
Ambient   black 
Diffuse  textured, all white texture 
Specular Level  0 

 
2. Rendering video warp frames 
� To get correct warp alpha channel, any objects occluding the video surface must 

have applied matte material. A receive shadows object property must be 
disabled. Objects that do not occlude video surface at any moment should be set 
non-renderable. 
 

� In order to get correct UV mapping on the output, an object within scene that will 
serve as video surface must have applied texture. UV mapping can be set up 
precisely using UVW Map modifier. 
 

� It is useful to adjust UV mapping to slightly extend the video surface (5% on each 
side). Doing this crops black border that often occurs in video signal. 
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APPENDIX B  
Pop-out Effect Scene Tutorial 
In this tutorial, you will learn how to create a simple pop-out effect using 3ds max. The 
tutorial requires basic knowledge of the 3ds max application workflow. 

What is Pop-out effect 

            →  
                         Input video                       Output video 
The effect can do whatever transformation like stretch, cloth effect, explosion. 

Create video surface 

The essential part of the scene is video surface object. User Field Product = Virtual 
Placement  uses video surface to display input video stream. 

 

1. Choose Create > Standard Primitives > Plane. In the Keyboard Entry rollout, set 
plane parameters: 
 
 Length:    9 
 Width:  16 
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Click Create button. 

The Length and Width parameters are chosen to match the video aspect of the output clip. 
For 4:3 aspect, use a Length=3, Width=4 values. 

2. Rename created plane object to VideoSurface. 

3. Adjust following parameters of the VideoSurface: 
 
 Length Segs: 1 
 Width Segs: 1 

4. Apply an UVW Mapping modifier onto the VideoSurface (Modifiers > UV Coordinates 
> UVW Map). Keep default modifier parameters. The UVW mapping controls future 
mapping of the video input stream onto the plane. 

 

Create And Setup Camera 

 

1. Create a free camera object (Create > Cameras > Free Camera). Pick somewhere to 
scene to create camera. 

2. Set rotate mode . In the transform type-in, set rotation angles to all zeroes. 

3. In the Parameters rollout, adjust camera FOV to 40 degrees. 

4. Set translate mode .  In order to align the VideoSurface with the camera view 
precisely, it is important to set up the camera distance from the surface. Using basic 
math, for given FOV and surface width, we compute camera distance as 

distance = width/(2 * tan(FOV/2)) 

For FOV = 40, use following table to decide camera distance: 
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video surface dimension (width, length) camera Z distance 
16 x 9 21.980 
4 x 3 5.495 
 

Set the distance to the transform type-in – e.g. X=0, Y=0, Z=21.980. 

Create Background Plane 

In the following step, we create a background image plane. 

1. Select VideoSurface object. Choose Edit > Clone. In the popup dialog, choose a 
Copy clone mode. 

2. Rename the object to a Background. 

3. Move Background slightly away from the camera to be behind the video surface 
from the camera point of view. Also, slightly increase it's size to cover whole camera 
field of view (it is possible to apply the same math we used to compute right camera 
– video surface distance). 

4. Apply a background material (color/texture) to the Background object. 

 

Animate VideoSurface 
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Now we create very simple animation of the video surface. In practice, it is possible to 
apply any 2D/3D animation/distortion to the surface. 

1. Enable Auto Key function in 3ds max. 
2. Move time slider to frame 50. 
3. Scale the VideoSurface object to desired size and place it to desired position over 

the background. Moving the time slider, the VideoSurface should be shrinknig from 
full-size (time 0) to chosen final position (frame 50). 

4. Disable Auto Key. 
Setup Video Surface Material 

1. Open Material Editor (Rendering > Material Editor). Choose any unused material. 
2. Make sure the material shader type is Blinn. 
3. Disable interlock of ambient and diffuse colors. Disable interlock of ambient and 

diffuse map. 
 

4. Make sure the Specular Level value is set to 0. 

 
5. Set ambient color to black. 
6. Set diffuse color to white. Assign a bitmap containing single white pixel (white.png) 

to the diffuse color. 
7. Select a VideoSurface object, assign a material to it . 

Set up Scene Lighting 

In order to avoid darkening of a video when the effect is applied, the VideoSurface color 
must be pure white in non-shaded areas. To achieve that, we have to set up a light source. 

1. Create new directional light (Create > Lights > Standard Lights > Directional). Pick 
somewhere into scene to create the light. 

2. Set rotate mode . In the light's transform type-in, zero-out all rotation angles. 
The light should be aiming to the same direction as the camera. 

3. Position the light to cover all objects in the scene by it's light cylinder. 
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Render RGBA channels 

Open Render Scene dialog. In the Output Size box, change type to Custom.  

Use following settings to render to different target formats: 

 Width Height Pixel 
Aspect 

Note 

SD 576 (PAL) 16:9 720 576 1.4222  
SD 576 (PAL) 4:3 720 576 1.0667  
SD 576 (PAL) 16:9 1024 576 1.0 can affect resulting effect quality, horizontal 

downsampling is necessary 
SD 576 (PAL) 4:3 768 576 1.0 can affect resulting effect quality, horizontal 

downsampling is necessary 
SD 486 (NTSC) 
16:9 

720 486 1.2  

SD 486 (NTSC) 
4:3 

720 486 0.9  

SD 486 (NTSC) 
16:9 

864 486 1.0 can affect resulting effect quality, horizontal 
downsampling is necessary 

HD 1080 1920 1080 1.0  
HD 720 1280 720 1.0  
 

Render a scene animation to standard RGBA output (e.g. png file sequence). 

Render UV and video alpha channels 



 

                              
 

121   |   Virtual Placement User Guide (v8.1)  

1. Hide any objects in the scene except the VideoSurface object and the objects that 
can potentially occlude the VideoSurface. 

2. In a Material Editor, select any unused material. Change material type to 
Matte/Shadow (Material > Change Material/Map Type... > Select Matte/Shadow). 
Make sure that the Opaque Alpha check box is not checked. 

3. Apply the material to any objects that can occlude the VideoSurface (there are none 
in our basic scene). 

4. Render the scene again, this time, use a RLA output format, with following settings: 
● Bits per channel: 8 
● Store alpha channel: enabled 
● Premultiply alpha: disabled 
● Optional channels: UV Coordinates 

Resulting image should look like following (RGB Alpha and UV Coordinates, respectively): 

                      

Create a .gtc clip 

1. Open GTC Clip Convertor application. 
2. Browse rendered .png file as a primary clip source file name.  
3. Enable the Warp Enable check box. 
4. Browse rendered .rla file as a warp source. 
5. Step through the application, creating the clip when finished. 
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APPENDIX C  
Application Variables 
User Field Product = Virtual Placement maintains a list of variables that you can use in the 
production. Typically, you can use the variables in the Text product, where the variable 
name is automatically translated to its value.  

List of available variables: 

Variable Description 
$(SCORE1) Value of score 1 from the score widget 
$(SCORE2) Value of score 2 from the score widget 
$(CLK;<time_format>) Clock 

<time_format> is optional, if missing, default local 
time format is used. See time format letters for 
available formatting. 
 
Examples: 
$(CLK) 
$(CLK;HH:mm) 
$(CLK;HH:mm:ss) 
$(CLK;hh:mm a) 

$(CLKCD;<finish_time>;<time_format>) Countdown clock until <finish_time>.. 
<time_format> is optional, if missing, default local 
time format is used. See time format letters for 
available formatting. 
 
Examples: 
$(CLKCD;19:00;HH:mm) 
$(CLKCD;19:00:00;HH:mm:ss) 
$(CLKCD;7:00 PM;hh:mm a) 

$(CLKCU,<start_time>;<time_format>) Count up clock from <start_time>. 
<time_format> is optional, if missing, default local 
time format is used. See time format letters for 
available formatting. 
 
Examples: 
$(CLKCU;19:00;HH:mm) 
$(CLKCU;7:00 PM;hh:mm a) 

$(USERTIME;<time_format>) User time adjusted via toolbar time button. 
<time_format> is optional, if missing, default local 
time format is used. See time format letters for 
available formatting. 
 
Examples: 
$(USERTIME) 
$(USERTIME;HH:mm) 



 

                              
 

123   |   Virtual Placement User Guide (v8.1)  

$(USERTIME;+ m:ss) 
$(HEIGHTMEASUREMENT) Value calculated from product HeightMeasurement. 

The value is height in fixed format with one decimal 
place, unit cm. 

$(DOWN) Current down number (in the form of text string, e.g. 
'3rd'). Available only when Down and Distance is 
enabled. 

$(DISTANCE) Current distance of the Scrimmage line to the Down 
line.  Available only when Down and Distance is 
enabled. 

$(DISTANCE;Goal;Inches) Current distance of the Scrimmage line to the Down 
line with customized wording. 

 
Usage of the variables is described in the Text product section.  
The text products are updated immediately when the variable value changes.  
List of available time format letters: 
 
Letter Date or time component Examples 

G Era designator AD (G) 
y Year 1996 (yyyy), 96 (yy) 

M Month in year July (MMMM), 07 (MM), 7 (M) 

w Week in year 27 (w) 
W Week in month 02 (WW), 2(W)  

D Day in year 189 (D), 08 (DD) 

d Day in month 10 (d), 01 (dd) 

F Day of week in month 3 (F) 
E Day in week Tuesday (EEEE), Tue (E) 

a Am/pm marker PM (a) 

H Hour in day (0-23) 0 (H), 00 (HH) 
k Hour in day (1-24) 24 (k), 08 (kk) 

K Hour in am/pm (0-11) 00 (KK), 0 (K) 

h Hour in am/pm (1-12) 12 (h), 01 (hh) 

m Minute in hour 30 (m) 02 (mm) 
s Second in minute 55 (ss) 

S Millisecond 987 (SSS) 

z Time zone Pacific Standard Time, PST, GMT-08:00 
Z Time zone RFC-822 -800 
 
Pattern letters are usually repeated, as their number determines the exact  number of digits. 
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APPENDIX D  
Soccer Calibration Images 
Center camera reference for soccer calibration. 
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Left camera reference for soccer calibration. 
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Right camera reference for soccer calibration. 
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APPENDIX E  
Football Calibration Images 
Game 1 (Left) camera reference for NCAA/NFL football calibration. 
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Game 2 (Center) camera reference for NCAA/NFL football calibration. 

 
 
 
 
Game 3 (Right) camera reference for NCAA/NFL football calibration. 
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Licenses 
FreeImage Public License - Version 1.0 
 
1. Definitions. 
1.1. "Contributor" means each entity that creates or contributes to the creation of Modifications. 
1.2. "Contributor Version" means the combination of the Original Code, prior Modifications used by a 
Contributor, and the Modifications made by that particular Contributor. 
1.3. "Covered Code" means the Original Code or Modifications or the combination of the Original Code 
and Modifications, in each case including portions thereof. 
1.4. "Electronic Distribution Mechanism" means a mechanism generally accepted in the software 
development community for the electronic transfer of data. 
1.5. "Executable" means Covered Code in any form other than Source Code. 
1.6. "Initial Developer" means the individual or entity identified as the Initial Developer in the 
Source Code notice required by Exhibit A. 
1.7. "Larger Work" means a work which combines Covered Code or portions thereof with code not 
governed by the terms of this License. 
1.8. "License" means this document. 
1.9. "Modifications" means any addition to or deletion from the substance or structure of either the 
Original Code or any previous Modifications. When Covered Code is released as a series of files, a 
Modification is: 
A. Any addition to or deletion from the contents of a file containing Original Code or previous 
Modifications. 
B. Any new file that contains any part of the Original Code or previous Modifications. 
1.10. "Original Code" means Source Code of computer software code which is described in the Source 
Code notice required by Exhibit A as Original Code, and which, at the time of its release under this 
License is not already Covered Code governed by this License. 
1.11. "Source Code" means the preferred form of the Covered Code for making modifications to it, 
including all modules it contains, plus any associated interface definition files, scripts used to 
control 
compilation and installation of an Executable, or a list of source code differential comparisons 
against either the Original Code or another well known, available Covered Code of the Contributor's 
choice. The Source Code can be in a compressed or archival form, provided the appropriate 
decompression or de-archiving software is widely available for no charge. 
1.12. "You" means an individual or a legal entity exercising rights under, and complying with all of 
the terms of, this License or a future version of this License issued under Section 6.1. For legal 
entities, "You" includes any entity which controls, is controlled by, or is under common control 
with You. For purposes of this definition, "control" means (a) the power, direct or indirect, to 
cause the 
direction or management of such entity, whether by contract or otherwise, or (b) ownership of fifty 
percent (50%) or more of the outstanding shares or beneficial ownership of such entity. 
 
2. Source Code License. 
2.1. The Initial Developer Grant. 
The Initial Developer hereby grants You a world-wide, royalty-free, non-exclusive license, subject 
to third party intellectual property claims: 
(a) to use, reproduce, modify, display, perform, sublicense and distribute the Original Code (or 
portions thereof) with or without Modifications, or as part of a Larger Work; and 
(b) under patents now or hereafter owned or controlled by Initial Developer, to make, have made, use 
and sell ("Utilize") the Original Code (or portions thereof), but solely to the extent that 
any such patent is reasonably necessary to enable You to Utilize the Original Code (or portions 
thereof) and not to any greater extent that may be necessary to Utilize further Modifications or 
combinations. 
 
2.2. Contributor Grant. 
Each Contributor hereby grants You a world-wide, royalty-free, non-exclusive license, subject to 
third party intellectual property claims: 
(a) to use, reproduce, modify, display, perform, sublicense and distribute the Modifications created 
by such Contributor (or portions thereof) either on an unmodified basis, with other Modifications, 
as Covered Code or as part of a Larger Work; and 
(b) under patents now or hereafter owned or controlled by Contributor, to Utilize the Contributor 
Version (or portions thereof), but solely to the extent that any such patent is reasonably necessary 
to enable You to Utilize the Contributor Version (or portions thereof), and not to any greater 
extent that 
may be necessary to Utilize further Modifications or combinations. 
 
3. Distribution Obligations. 
3.1. Application of License. 
The Modifications which You create or to which You contribute are governed by the terms of this 
License, including without limitation Section 2.2. The Source Code version of Covered Code may be 
distributed only under the terms of this License or a future version of this License released under 
Section 6.1, and You must include a copy of this License with every copy of the Source Code You 
distribute. You may not offer or impose any terms on any Source Code version that alters or 
restricts the applicable version of this License or the recipients' rights hereunder. However, You 
may include an additional document offering the additional rights described in Section 3.5. 
3.2. Availability of Source Code. 
Any Modification which You create or to which You contribute must be made available in Source Code 
form under the terms of this License either on the same media as an Executable version or via an 
accepted Electronic Distribution Mechanism to anyone to whom you made an Executable version 
available; and if made available via Electronic Distribution Mechanism, must remain available for at 
least twelve (12) months after the date it initially became available, or at least six (6) months 
after a subsequent version of that particular Modification has been made available to such 
recipients. You are responsible for ensuring that the Source Code version remains available even if 
the Electronic Distribution Mechanism is maintained by a third party. 
3.3. Description of Modifications. 
You must cause all Covered Code to which you contribute to contain a file documenting the changes 
You made to create that Covered Code and the date of any change. You must include a prominent 
statement that the Modification is derived, directly or indirectly, from Original Code provided by 
the Initial Developer and including the name of the Initial Developer in (a) the Source Code, and 
(b) in any notice in an Executable version or related documentation in which You describe the origin 
or ownership of the Covered Code. 
3.4. Intellectual Property Matters 
(a) Third Party Claims. 
If You have knowledge that a party claims an intellectual property right in particular functionality 
or code (or its utilization under this License), you must include a text file with the source code 
distribution titled "LEGAL" which describes the claim and the party making the claim in sufficient 
detail that a recipient will know whom to contact. If you obtain such knowledge after You make Your 
Modification available as described in Section 3.2, You shall promptly modify the LEGAL file in all 
copies You make 
available thereafter and shall take other steps (such as notifying appropriate mailing lists or 
newsgroups) reasonably calculated to inform those who received the Covered Code that new knowledge 
has been obtained. 
(b) Contributor APIs. 
If Your Modification is an application programming interface and You own or control patents which 
are reasonably necessary to implement that API, you must also include this information in the LEGAL 
file. 
3.5. Required Notices. 
You must duplicate the notice in Exhibit A in each file of the Source Code, and this License in any 
documentation for the Source Code, where You describe recipients' rights relating to Covered Code. 
If You created one or more Modification(s), You may add your name as a Contributor to the notice 
described in Exhibit A. If it is not possible to put such notice in a particular Source Code file 
due to its 
structure, then you must include such notice in a location (such as a relevant directory file) where 
a user would be likely to look for such a notice. You may choose to offer, and to charge a fee for, 
warranty, support, indemnity or liability obligations to one or more recipients of Covered Code. 
However, You may do so only on Your own behalf, and not on behalf of the Initial Developer or any 
Contributor. You must make it absolutely clear than any such warranty, support, indemnity or 
liability obligation is offered by You alone, and You hereby agree to indemnify the Initial 
Developer and every Contributor for any liability incurred by the Initial Developer or such 
Contributor as a result of 
warranty, support, indemnity or liability terms You offer. 
3.6. Distribution of Executable Versions. 
You may distribute Covered Code in Executable form only if the requirements of Section 3.1-3.5 have 
been met for that Covered Code, and if You include a notice stating that the Source Code version of 
the Covered Code is available under the terms of this License, including a description of how and 

where You have fulfilled the obligations of Section 3.2. The notice must be conspicuously included 
in any notice in an Executable version, related documentation or collateral in which You 
describe recipients' rights relating to the Covered Code. You may distribute the Executable version 
of Covered Code under a license of Your choice, which may contain terms different from this License, 
provided that You are in compliance with the terms of this License and that the license for the 
Executable version does not attempt to limit or alter the recipient's rights in the Source Code 
version from the rights set forth in this License. If You distribute the Executable version under a 
different license You must make it absolutely clear that any terms which differ from this License 
are offered by You alone, not by the Initial Developer or any Contributor. You hereby agree to 
indemnify the Initial Developer and every Contributor for any liability incurred by the Initial 
Developer or such Contributor as a result of any such terms You offer. 
3.7. Larger Works. 
You may create a Larger Work by combining Covered Code with other code not governed by the terms of 
this License and distribute the Larger Work as a single product. In such a case, You must make sure 
the requirements of this License are fulfilled for the Covered Code. 
 
4. Inability to Comply Due to Statute or Regulation. 
 
If it is impossible for You to comply with any of the terms of this License with respect to some or 
all of the Covered Code due to statute or regulation then You must: (a) comply with the terms of 
this License to the maximum extent possible; and (b) describe the limitations and the code they 
affect. Such description must be included in the LEGAL file described in Section 3.4 and must be 
included with all distributions of the Source Code. Except to the extent prohibited by statute or 
regulation, such description must be sufficiently detailed for a recipient of ordinary skill to be 
able to understand it. 
 
5. Application of this License. 
 
This License applies to code to which the Initial Developer has attached the notice in Exhibit A, 
and to related Covered Code. 
 
6. Versions of the License. 
6.1. New Versions. 
Floris van den Berg may publish revised and/or new versions of the License from time to time. Each 
version will be given a distinguishing version number. 
6.2. Effect of New Versions. 
Once Covered Code has been published under a particular version of the License, You may always 
continue to use it under the terms of that version. You may also choose to use such Covered Code 
under the terms of any subsequent version of the License published by Floris van den Berg 
No one other than Floris van den Berg has the right to modify the terms applicable to Covered Code 
created under this License. 
6.3. Derivative Works. 
If you create or use a modified version of this License (which you may only do in order to apply it 
to code which is not already Covered Code governed by this License), you must (a) rename Your 
license so that the phrases "FreeImage", `FreeImage Public License", "FIPL", or any confusingly 
similar phrase do not appear anywhere in your license and (b) otherwise make it clear that your 
version of the license contains terms which differ from the FreeImage Public License. (Filling in 
the name of the Initial Developer, Original Code or Contributor in the notice described in Exhibit A 
shall not of themselves be deemed to be modifications of this License.) 
 
7. DISCLAIMER OF WARRANTY. 
COVERED CODE IS PROVIDED UNDER THIS LICENSE ON AN "AS IS" BASIS, WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE COVERED CODE IS FREE 
OF DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING. THE ENTIRE RISK AS TO THE 
QUALITY AND PERFORMANCE OF THE COVERED CODE IS WITH YOU. SHOULD ANY COVERED CODE PROVE DEFECTIVE IN 
ANY RESPECT, YOU (NOT THE INITIAL DEVELOPER OR ANY OTHER CONTRIBUTOR) ASSUME THE COST OF ANY 
NECESSARY SERVICING, REPAIR OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART 
OF THIS LICENSE. NO USE OF ANY COVERED CODE IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER. 
 
8. TERMINATION. 
This License and the rights granted hereunder will terminate automatically if You fail to comply 
with terms herein and fail to cure such breach within 30 days of becoming aware of the breach. All 
sublicenses to the Covered Code which are properly granted shall survive any termination of this 
License. Provisions which, by their nature, must remain in effect beyond the termination of this 
License shall survive. 
 
9. LIMITATION OF LIABILITY. 
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER TORT (INCLUDING NEGLIGENCE), CONTRACT, OR 
OTHERWISE, SHALL THE INITIAL DEVELOPER, ANY OTHER CONTRIBUTOR, OR ANY DISTRIBUTOR OF COVERED CODE, 
OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, 
DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER 
COMMERCIAL DAMAGES OR LOSSES, EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH 
DAMAGES. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY 
RESULTING FROM SUCH PARTY'S NEGLIGENCE TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. SOME 
JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THAT EXCLUSION AND LIMITATION MAY 
NOT APPLY TO YOU. 
 
10. U.S. GOVERNMENT END USERS. 
The Covered Code is a "commercial item," as that term is defined in 48 C.F.R. 2.101 (Oct. 1995), 
consisting of "commercial computer software" and "commercial computer software documentation," as 
such terms are used in 48 C.F.R. 12.212 (Sept. 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 
227.7202-1 through 227.7202-4 (June 1995), all U.S. Government End Users acquire Covered Code with 
only those rights set forth herein. 
 
11. MISCELLANEOUS. 
This License represents the complete agreement concerning subject matter hereof. If any provision of 
this License is held to be unenforceable, such provision shall be reformed only to the extent 
necessary to make it enforceable. This License shall be governed by Dutch law provisions (except to 
the extent applicable law, if any, provides otherwise), excluding its conflict-of-law provisions. 
With respect to disputes in which at least one party is a citizen of, or an entity chartered or 
registered to do business in, the The Netherlands: (a) unless otherwise agreed in writing, all 
disputes relating to this License (excepting any dispute relating to intellectual property rights) 
shall be subject to final and binding arbitration, with the losing party paying all costs of 
arbitration; (b) any arbitration relating to this Agreement shall be held in Almelo, The 
Netherlands; and (c) any litigation relating to this Agreement shall be subject to the jurisdiction 
of the court of Almelo, The Netherlands with the losing party responsible for costs, including 
without limitation, court costs and reasonable attorneys fees and expenses. Any law or regulation 
which provides that the language of a contract shall be construed against the drafter shall not 
apply to this License. 
 
12. RESPONSIBILITY FOR CLAIMS. 
Except in cases where another Contributor has failed to comply with Section 3.4, You are responsible 
for damages arising, directly or indirectly, out of Your utilization of rights under this License, 
based 
on the number of copies of Covered Code you made available, the revenues you received from utilizing 
such rights, and other relevant factors. You agree to work with affected parties to distribute 
responsibility on an equitable basis. 
 
EXHIBIT A. 
"The contents of this file are subject to the FreeImage Public License Version 1.0 (the "License"); 
you may not use this file except in compliance with the License. You may obtain a copy of the 
License at http://home.wxs.nl/~flvdberg/freeimage-license.txt 
Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY 
KIND, either express or implied. See the License for the specific language governing rights and 
limitations under the License.  
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ABOUT US 
Chyron is ushering in the next generation of storytelling in the digital age. Founded in 1966, 
the company pioneered broadcast titling and graphics systems. With a strong foundation 
built on over 50 years of innovation and efficiency, the name Chyron is synonymous with 
broadcast graphics. Chyron continues that legacy as a global leader focused on customer-
centric broadcast solutions. Today, the company offers production professionals the 
industry’s most comprehensive software portfolio for designing, sharing, and playing live 
graphics to air with ease. Chyron products are increasingly deployed to empower OTA & 
OTT workflows and deliver richer, more immersive experiences for audiences and sports 
fans in the arena, at home, or on the go. 

CONTACT SALES 
EMEA • North America • Latin America • Asia/Pacific 
+1.631.845.2000 •  sales@chyron.com 
 


